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1

第1章 序

ParaViewは、2次元および 3次元データセットを可視化するためのオープンソー
スアプリケーションです。ParaViewが扱えるデータセットの大きさは、ParaViewが
実行されるプラットフォームのアーキテクチャによって大きく変わります。ParaView
によってサポートされるプラットフォームは、シングルプロセッサのワークステー
ションから、多数のプロセッサによって構成される分散メモリスーパーコンピュー
タやワークステーションクラスタまで、多岐に渡ります。並列コンピュータを利用
することで、ParaViewは巨大なデータセットを並列に処理し、その後で処理結果を
集約することができます。ParaViewでは数十億セルの非構造メッシュ、1兆セルを
超える構造メッシュを処理できることが確認されています。ParaViewの並列フレー
ムワークは 10万を超える実行コアで動作します。
ParaViewの設計においては、以下のような多くの特徴により、他の科学データ可

視化ソリューションとの差別化を図っています。

• オープンソース、スケーラブル、かつマルチプラットフォームな可視化アプリ
ケーション。

• 大容量データセットを処理するための分散型計算手法のサポート。

• オープン、柔軟かつ直感的なユーザインターフェイス。

• オープンな規格に基づいた拡張性の高いモジュール化構造。

• 柔軟な 3条項BSDライセンス。

• 有償の保守およびサポート。

ParaViewは世界中の多くの学術、公的、および商業機関に
よって利用されています。ParaViewのオープンなライセンス
の下では、ParaViewにどれだけのユーザーがいるのか正確
に追跡することは不可能ですが、間接的な証拠から数万もの
のユーザーがいると考えられています。例えばParaViewは
年間に約 10万回ダウンロードされています。またParaView

は最優秀HPC可視化製品・技術部門で 2010年と 2012年に
HPCwire読者賞を、2010年にHPCwire編集者賞を獲得して
います。



2 第 1 章 序

平面波を受ける ZSU23-4ロシア製対空車両。
画像提供 アメリカ陸軍研究所 Jerry Clarke。

横 風 火 災 に お け る 物 体 の 、1000
万 の 非 構 造 6 面 体 セ ル に よ る
SIERRA/Fuego/Syrinx/Calore を 用 い
た弱連成シミュレーション。

ペルトン・タービンのシミュ
レーション。画像提供スイス
国立スーパーコンピューティ
ングセンター。

ル・マンのレースカー周りの気流。画像提供 ブラジル リオ・
デ・ジャネイロ NACAD/COPPE/UFRJ Renato N. Elias。

これらの可視化の例に見られるように、ParaViewは幅広い用途のための汎用ツール
です。小規模データから大規模データまでのスケーリング機能に加えて、ParaView

では多くの汎用可視化アルゴリズムと、特定の科学分野に特化したいくつかの機
能を使用することができます。さらにカスタムした可視化アルゴリズムを使って、
ParaViewのシステムを拡張することも可能です。



1.1. 開発および資金提供 3

MPI OpenGL IceT Etc. 

VTK 

ParaView Server 

ParaView Client pvpython Custom App 

UI (Qt Widgets, Python Wrappings) 

ParaWeb Catalyst 

ParaViewとしてユーザから見えるアプリケーションの実体は、ParaView自体の
機能を構成する何層ものライブラリ群の上に構築された、小さなクライアントに過
ぎません。上の図に示すように、ParaViewのほとんどの機能はライブラリとして
実装されているため、以下の図に示すように 1ParaViewの GUIをカスタムアプリ
ケーションによって完全に置き換えることが可能です。さらに、ParaViewに付属す
る pvpythonアプリケーションによって、Pythonスクリプトを用いて可視化とポ
ストプロセッシングを自動化することが可能です。
ParaViewアプリケーションのそれぞれに対し、コードを最大限に共有化するため

のユーザインターフェイス部品のライブラリが利用可能です。ParaViewサーバ・
ライブラリによって、並列かつインタラクティブな可視化を実行するための抽象化
レイヤが提供されます。ParaViewサーバ・ライブラリによって、クライアントアプ
リケーションはParaViewが並列に実行されているか否か、またどのように並列実行
されているか、といったことに関する問題の多くから解放されます。Visualization

Toolkit (VTK) は、基本的な可視化およびレンダリング・アルゴリズムを提供し
ます。VTKにはレンダリング、並列処理、ファイル入出力、並列レンダリングのよ
うな基本的な機能を提供するライブラリも含まれます。このチュートリアルでは、
ParaViewに付属するクライアントアプリケーションを使用してParaViewの使い方
を説明しますが、ParaView自体は、その高度に部品化された設計によって、大幅な
柔軟性およびカスタマイズの可能性を有しています。

1.1 開発および資金提供
ParaViewのプロジェクトは、Kitware Inc.とロスアラモス国立研究所の共同努力

によって 2000年に開始されました。初期の資金は、米エネルギー省ASCI Views計
1訳注: 実際には図は省略されているようです。
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画との 3年契約によって提供されました。最初の公開リリースであるParaView 0.6

は、2002年 10月にアナウンスされました。ParaViewの開発は、Kitware Inc.とサ
ンディア国立研究所、ロスアラモス国立研究所、陸軍研究所、およびその他多くの
学術・政府機関との共同作業によって継続されました。
2005年 9月には、Kitware、サンディア国立研究所、およびCSimSoftはParaView

3.0の開発を開始しました。この開発においては、ユーザインターフェイスをさらに
ユーザフレンドリに書き直し、定量的な分析のためのフレームワークを開発するこ
とに注力しました。ParaView3.0は 2007年 5月にリリースされました。
その後も、ParaViewの開発は続けられました。2013年 6月には ParaView4.0が
リリースされ、より統一的なGUIコントロールと改善されたマルチブロック操作が
導入されました。また、ParaViewの最近のリリースには、シミュレーションやその
他のアプリケーションに実行中可視化機能を統合する、Catalystライブラリが含ま
れています。
ParaViewの開発は、今日も続いています。サンディア国立研究所は、ASC計画を通
じ、ParaViewの開発への資金提供を続けています。ParaViewは、SciDAC Scalable

Data Management, Analysis, and Visualization (SDAV) Institute Toolkit (sdav-

scidac.org) の一部として使用されています。米エネルギー省は、ロスアラモス国立
研究所、さまざまな中小企業技術革新制度のプロジェクト、およびその他の契約を通じ
てParaViewに資金提供しています。米国立科学財団もまた、中小企業技術革新制度に
よって頻繁にParaViewに資金提供しています。フランス電力公社、Mirarco、石油関
連企業など、その他の機関もParaViewへの支援を行っています。さらに、ParaView
はオープンソースプロジェクトであるため、スイス国立スーパーコンピューティン
グセンターのような機関も開発成果をコントリビュートしています。

1.2 可視化の基礎

簡単に言うと、可視化の過程とは、生のデータを人間が見て理解することができ
る形式に変換することです。このことによって、データをより感覚的に理解するこ
とができるようになります。科学的な可視化では特に、2次元あるいは 3次元空間

http://sdav-scidac.org
http://sdav-scidac.org
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において明確な表現を有するデータを取扱います。シミュレーションのメッシュや
スキャナのデータに由来するデータは、この種の分析に特に向いています。
データの可視化には、大別して 3つの段階があります。すなわち、読込み、フィル

タリング、レンダリングです。まず、データを ParaViewに読み込みます。つぎに、
データから特徴を生成、抽出、導出するためにデータを処理するフィルタを、必要
なだけ適用します。最後に、可視化された画像がデータからレンダリングされます。
ParaViewは基本的に、空間的に表現されるデータを取扱います。したがって、Para-

Viewが使用する基本的なデータ型はメッシュ (または格子) です。

一様直線格子 (画像データ)

等間隔直線格子は1、2、または3次元の配列デー
タです。格子点は互いに直交し、各方向に等間
隔に配置されます。

非一様直線格子 (直線格子)

等間隔直線格子と似ていますが、格子点間の距
離を各座標軸方向に変化させることができます。

曲線格子 (構造格子)

曲線構造格子は、直線格子と同じトポロジを有
します。ただし、曲線格子上の格子点は (セルど
うしが重なったり、自分自身と交差しない限り)

任意の座標に置くことができます。曲線格子は
直線格子の比較的少ないメモリ使用量、暗黙の
トポロジといった特徴を継承しつつ、メッシュの
形状に大幅な自由度を与えることができます。
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ポリゴン・データ (ポリ・データ)

ポリゴン・データセットは、点、直線、2次元の
任意多角形から構成されます。セル間の結合は
任意であり、結合しないこともできます。
レンダリングにおける基本的なプリミティブは、
ポリゴン・データによって表されます。あらゆ
るデータは、(ボリュームレンダリングを除いて)

レンダリングの前に必ずポリゴン・データに変
換されますが、この変換はParaViewによって自
動的に行われます。

非構造格子
非構造格子データセットは、点、直線、2次元の
任意多角形、3次元 4面体、非線形セルから構成
されます。ポリゴン・データと類似しています
が、直接レンダリングできないような、3次元
の四面体 2や非線形セルも表現することができ
ます。

これらの基本的なデータ型に加えて、ParaViewはマルチブロックデータもサポー
トしています。データセットがグループ化されたときや複数のブロックから成るファ
イルが読み込まれた時には、必ずマルチブロックのデータセットが生成されます。
ParaViewはさらに、階層化適応メッシュ分割 (AMR)、階層化一様AMR、八分木、
表、そしてグラフデータセットを表現するためのデータ型を有します。

1.3 さらなる情報
様々なところから、ParaView に関するさらなる情報を入手するこ
とができます。ParaView ユーザーマニュアルは電子書籍とオンライン
http://paraview.org/Wiki/ParaView/Users Guide/Table Of Contents で 利 用
可能です。また ParaViewにはオンラインのヘルプもあります。アプリケーション
の ボタンをクリックするとヘルプにアクセスすることが可能です。
ParaViewのウエブページwww.paraview.orgもまた、ParaViewに関するさらなる
情報を入手する絶好のサイトです。このサイトから、メーリングリスト、Wiki、よ
くある質問集、さらには有償サポートサービスへのリンクを辿ることができます。

2訳注: ピラミッド、プリズム、六面体などもサポートしています。

http://paraview.org/Wiki/ParaView/Users_Guide/Table_Of_Contents
http://www.paraview.org
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それでは、ParaViewを使ってみましょう。ここから先の内容を進めるには、自身で
ParaViewをインストールして頂く必要があります。とりわけ、この文書はParaView

のバージョン 4.2 に基づいています。既にParaViewのバージョン 4.2 をお持ちでな
ければ、www.paraview.orgからダウンロードできます (ダウンロードへのリンクを
クリックして下さい)。ParaViewは、大抵のアプリケーションと同じようにして起
動します。Windowsでは、スタート・メニューから起動します。Macintoshでは、イ
ンストールしたアプリケーション・バンドルを開いて下さい。Linuxでは、コマン
ド・プロンプトから paraviewを実行して下さい (パスが設定されている必要があり
ます)。
このチュートリアルの例では、http://www.paraview.org/Wiki/The ParaView -

Tutorial から入手可能なデータを使用します。このデータを、簡単にアクセスでき
る適当なディレクトリにインストールして下さい。このチュートリアルによってファ
イルを読み込むよう指示された時は、このデータをインストールしたディレクトリ
から読み込んで下さい。

2.1 ユーザ・インターフェイス
Menu Bar 

Toolbars 

Pipeline Browser 

Properties Panel 

3D View 

Advanced Toggle 

ParaViewのGUIは、実行されているプラットフォームにおける形式 (ルック・ア
ンド・フィール) に従いますが、基本的には全てのプラットフォームで同じようにふ
るまいます。ここに示したレイアウトは、ParaViewが最初に起動された時のデフォ
ルトのレイアウトです。GUIは以下の要素から構成されます。

http://www.paraview.org
http://www.paraview.org/Wiki/The_ParaView_Tutorial
http://www.paraview.org/Wiki/The_ParaView_Tutorial
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メニュー・バー 他のプログラムと同様に、メニューバーから大部分の機能を利用す
ることが可能です。

ツール・バー ツール・バーによって、ParaViewの中でも最も一般的に使用される
機能を素早く利用することができます。

Pipeline Browser (パイプライン・ブラウザ) ParaViewは、パイプラインによっ
てデータの読み込みとフィルタリングを管理します。パイプライン・ブラウザ
によって、パイプラインの構造を表示し、パイプライン・オブジェクトを選択
することができます。パイプライン・ブラウザは、パイプライン構造をインデ
ントして表現する、パイプライン・オブジェクトの明快なリストです。

Properties Panel (プロパティ・パネル) プロパティ・パネルでは、現在選択され
ているパイプライン・オブジェクトの設定を表示および変更することができ
ます。プロパティ・パネル上では、高度なプロパティの切り替え で高度
なコントロール 1 の表示、非表示を切り替えられます。デフォルトではプロ
パティはオブジェクトによって生成されたデータの基本情報を表示している
Informationタブと一体になっています。

3D View (3Dビュー) GUIの残りの部分はデータの提示に使用され、ここでデー
タを表示・操作・分析することができます。この部分は、データの幾何的表現
を提示する 3D Viewで初期化されます。

ここで留意すべきは、GUIのレイアウトは大幅に設定変更が可能であり、そのた
めウインドウの見た目の変更が容易であることです。ツールバーは各所に移動し、
あるいは隠すこともできます。ツールバーの表示を変更するには、View → Toolbars

メニューを使用して下さい。パイプライン・ブラウザとプロパティ・パネルは、い
ずれもドッキング可能なウインドウです。すなわち、これらの要素はGUIの中を各
所に移動したり、フローティング・ウインドウとして切離したり、完全に隠すこと
ができます。これらの 2つのウインドウはParaViewの操作に重要なので、これらを
隠した後に再度必要となった場合は、Viewメニューから表示することができます。

2.2 ソース
ParaViewにデータを入力するには、2とおりの方法があります。すなわち、デー
タをファイルから読み込むか、またはソースオブジェクトによって生成する方法で
す。全てのソースは Sourcesメニューにあります。ソースによって例えば、ビューに
注記を追加することもできますし、ParaViewの機能を (実際に動作させながら) 調
べたい時にも非常に便利です。

1訳注: コントロールとは、ボタン、チェックボックス、ドロップダウンメニュー、テキスト入力
フィールド等の、ユーザが操作する画面上の部品のことです。
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演習 2.1: ソースの作成
簡単な例から始めましょう。Sourcesメニューから、Cylinder (シリンダ) を選択して
下さい。そうすると、パイプライン・ブラウザに Cylinder1という項目が追加され、
選択された状態となります。さらに、プロパティ・パネルには、シリンダ・ソース
のプロパティが表示されています。ここではデフォルトの設定で良いので、そのま
ま Apply ボタン をクリックして下さい。
Applyをクリックすると、シリンダ・オブジェクトが右側の 3Dビュー・ウインド

ウに表示されます。
♦

さて、一番最初の単純な可視化結果が作成できました。これを操作していきましょ
う。ParaViewにはたくさんの可視化結果を操作する方法があります。それではまず
3Dビュー上のデータを調べてみましょう。

演習 2.2: 3Dビューの操作
この演習は、演習 2.1の続きです。こちらを始める前に、まず演習 2.1を完了させて
下さい。
3Dビューでは、3Dビュー上でマウスをドラッグすることで、円筒を操作するこ

とができます。マウスのそれぞれのボタン (左、中、右) を押しながらドラッグする
ことで、回転、平行移動、ズームの操作を行えます。また、シフトやCtrlキーなど
の修飾キーを押しながら、同様の操作を行ってみて下さい。

ParaViewには、カメラ操作を手助けするためのツールバーがいくつかあります。
その 1つ目が Camera Controlsツールバーで、ここで示すように、特定のカメラ・
ビューにすばやくアクセスする機能を提供します。左端のボタン でカメラのリ
セット、つまり同じ視点方向を維持したままオブジェクト全体が見えるようにカメ
ラ位置を変更することができます。2番目のボタン では、データにズームするこ
とができます。この機能はカメラのリセットに非常によく似ていますが、データ全
体が見えるようにカメラを配置する代わりに、現在パイプライン・ブラウザで選択
されているデータが見えるようにカメラを配置します。今はパイプライン・ブラウ
ザにオブジェクトが 1つしかないので、カメラのリセットとデータにズームは全く
同じ動作をするはずです。
カメラコントロール・ツールバーの次のボタン を使うと、画面上の長方形領域

を選択してズーム (ラバーバンド・ズーム)することができます。それに続く 6つの
ボタンでは、いずれかのグローバル座標軸の正または負方向から眺めるようにカメ
ラを配置します。これらのコントロールを、色々試してみてください。
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2つ目のツールバーは、回転中心位置と座標軸の表示を制御します。右端のボタ
ン を使うと、回転中心をピックすることができます。ボタンを押してから、円筒
上のどこかをクリックしてみてください。その後、3Dビュー上で左ボタンをドラッ
グすると、円筒がこの新しい点を中心に回転します。左隣のボタン を使うと、回
転中心をオブジェクトの中心に変更することができます。
その左隣のボタン で、回転中心位置に描画される軸の表示、非表示を切り替え
ることができます (回転中心が円筒の中心に設定されている場合には、軸が円筒に
隠れてしまうため、恐らく変化に気がつかないでしょう。再度、回転中心のピック
を行ってください。そうすれば変化を確認することができるはずです)。最後の

左端のボタン では、座標軸の表示、非表示を切り替えられます。座標軸とは、3D

ビューの左下隅に常に表示されている軸のことです。 ♦

3Dコントロールの操作は可視化における必要不可欠なものですが、同じように
重要な機能が、データ処理と表示のパラメータの変更です。ParaViewには、可視化
パラメータを変更するための数多くのGUIコンポーネントがあります。次の例題で
は、それらを見ていくことにしましょう。

演習 2.3: 可視化パラメータの変更
この演習は、演習 2.2の続きです。こちらを始める前に、まず演習 2.2を完了させて
下さい。
ParaViewによって作成されるシリンダ・オブジェクトは真の円筒ではなく、多角
形小面による円筒の近似であることにお気づきと思います。シリンダ・ソースのデ
フォルト設定では、わずか 6小面からなる非常に粗い近似が生成されます (実際のと
ころ、このオブジェクトは円筒というより多角柱に近く見えます)。より円筒らしい
表現が必要であれば、Resolutionパラメータの値を増やすことで、円筒に近い形に
することができます。

スライダもしくはテキスト入力フィールドを使用して、分割数を 50、またはそれ
以上にして下さい。するとApplyボタン が青色で点滅を始めたことに気が
つくでしょう。これは、オブジェクト・プロパティに対して行った変更が即座には適
用されないためです。ハイライト状態のボタンは、パイプライン・オブジェクトの
いずれかの設定が、現在表示されているものから変更されていることを示していま
す。Applyボタンをクリックするとこれらの変更が適用され、Resetボタン
をクリックすると、全ての設定が最後に適用された時の状態に戻ります。ここでは、
Applyボタンをクリックして下さい。真の円筒とほとんど見分けがつかない程、分
割数が変わる筈です。
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プロパティ・パネルを下にスクロールすると、一連のDisplayプロパティに気がつ
くでしょう。今回は、これらのプロパティのうちの Edit ボタンをクリックして、
円筒の色を変更してみましょう (このボタンと同じ物がツールバーにもあります)。
ディスプレイ・プロパティの場合には、Apply を押す必要はありません。

さらに下にスクロールしてプロパティ・パネルの一番下までいくと、Viewプロパ
ティがあります。このビュー・プロパティを使って、表示の背景を変更してみましょ
う。背景を Single colorからGradient へ変更してください。背景にグラデーションを
使うと見栄えが良くなりますが、同時に可視化時にデータに集中しづらくなります。
ビュー・オプションやオブジェクト・ディスプレイ・オプションのいくつかは、利
便性のために ParaViewのGUIの別の場所にも現れることに注意してください。
デフォルトでは、あまり使われないディスプレイ・プロパティの多くは、非表示

になっています。高度なプロパティの切り替え を使うと、それらのパラメータ
の表示、非表示を切り替えることができます。また、プロパティ・パネルの最上段
には検索ボックスがあり、これを使うとすばやくプロパティを探すことができます。
この検索ボックスに、specularと入力してみてください。ディスプレイ・プロパティ
の下に、Specularという名前のオプションがあるのがわかるでしょう。このオプショ
ンは、光沢のあるオブジェクトに見られる鏡面ハイライトの強度を制御するための
ものです。このパラメータを 1に設定して、円筒に光沢を与えてみてください。
ほとんどのオブジェクトは、同じようなディスプレイ・プロパティ、ビュー・プロ

パティを持っています。ほとんどのオブジェクトに対して行える、プロパティ・パ
ネル上のパラメータを使った他の技法についてもここで紹介しますので、試してみ
てください。
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• Cube Axesの下の Show Axesチェックボックスをクリックすると、オブジェク
トの端部に、各方向の物理的な距離を示す目盛の付いた 3D軸が表示されます。

• オブジェクトのOpacityパラメータを変更することで、オブジェクトを半透明
にします。不透明度パラメータを 1にすると完全に不透明になり、0にすると
完全に透明になり、その間の値では様々な度合いの透明度になります。

• 3Dレンダリングでのデフォルトの光源設定は、オブジェクトの構造が最もよ
く見えるような自然な濃淡が得られる位置になっています。もし光源を変更し
たい場合 (例えばカメラに向いた平面を明るく表示したい場合)には、Lightsオ
プション (高度なオプション)の下の Editボタンをクリックしてください。

♦

ここで、ツールバーの取消し および再実行 ボタンを紹介します。データの
可視化は多くの場合、試行錯誤の過程であり、一つ前の状態に戻れることが有用な
状況があります。実際、データを作成する前の時点にまで取消しで戻って、再実行
を行うことができます。

演習 2.4: 取消しおよび再実行
取消し ボタンと再実行 ボタンを試してみて下さい。もしその為の準備が整っ
ていないのなら、演習 2.1で行ったように、パイプライン・オブジェクトを作成お
よび変更して下さい。設定の変更が取消されたり、再び適用される様子を見てくだ
さい。同様に、パイプライン・オブジェクトの全体が消去されたり、再度作成され
たりする様子も見て下さい。
さらに、カメラ操作の取消し 、およびカメラ操作の再実行 ボタンがありま
す。これらによって、今までに試行したカメラのアングルを行ったり来たりするこ
とができ、マウス操作の誤りによって完璧なカメラアングルが崩れることを心配す
る必要がなくなります。カメラを様々に動かして、これらのボタンでカメラ操作を
取消したり、再実行してみて下さい。 ♦

シリンダ・ソースを扱うのはここまでです。パイプライン・ブラウザでシリンダ
が選択されているのを確認して、プロパティ・パネルにあるデリート を
押してください。パイプライン・オブジェクトを削除することができます。

2.3 データの読込み
ParaViewのGUIはいくらか練習しましたので、実際のデータを読込んでみましょ
う。ご想像のとおり、Fileメニューの最初の項目にOpenコマンドがあり、さらにツー
ルバーにもファイルを開くためのボタン があります。ParaViewは現在、140以
上のファイル形式をサポートし、ファイル形式のリストは新たな形式が追加される
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度に長くなっています。現在サポートされているファイルのリストを確認するには、
Openコマンドを実行し、Files of type選択ボックスのファイルのリストを見てくだ
さい。

モジュール化されたParaViewの設計によって、新たなVTKの読込みオブジェク
トの ParaViewへの統合が容易になっています。従って、新たなファイル形式がサ
ポートされていないか、頻繁にチェックされることをお勧めします。もし、お探しの
ファイル読込みオブジェクトがParaViewに含まれていないようであれば、ParaView
メーリングリスト (paraview@paraview.org) で調べてみて下さい。ParaViewからは
見えないものの、VTKには含まれており、容易に追加できるファイル読込みオブ
ジェクトも多数あります。さらにはVTKフレームワークへの組み込みが可能であり
ながら、VTKにはまだ組み込まれていない読み込みオブジェクトも多数あります。
誰かがあなたの必要な読込みオブジェクトをそのような形で持っており、快く提供
してくれるかもしれません。

演習 2.5: ファイルを開く
それでは、初めてのファイルを開いてみましょう。Openツールバー (もしくはメニュー
項目) をクリックし、disk out ref.ex2を開いて下さい。ファイルを開く操作は 2

段階の操作であり、この段階では、まだ読込んだデータは見られないことに注意し
て下さい。その代わり、プロパティ・パネルに、どのようにデータを読み込むかを
指定するための設定が提示されます。

Variables (変数) リストのヘッダ (最上部) にあるチェックボックスをクリックし、
全ての変数が読込まれるようにして下さい。これは小さなデータセットなので、メ

mailto:paraview@paraview.org
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モリに読み込むデータ量が過大になることを心配する必要はありません。全ての変
数を選択したら、 をクリックして全てのデータを読込んで下さい。データ
が読込まれたら、一端に穴の開いた円筒のような形状が表示されます。このデータ
は、加熱された回転円盤周囲の気流シミュレーションの結果です。表示されている
メッシュは円盤周りの空気です (シミュレーションの領域境界が円筒形になっていま
す)。真ん中の中空部分は、もしこのシミュレーションのためにこの部分もメッシン
グされていれば、加熱された円盤が存在するはずの場所です。 ♦

多くの場合、ParaViewはファイル拡張子と内部のデータに基いて、演習 2.5の時
のように、ファイルを適切に読み取る方法を決定することができるでしょう。しか
し、ParaViewは非常に多くのファイル形式をサポートしているので、なかには完全
に決定することができないファイルもあります。その場合、ParaViewはどの種類の
ファイルを読み込むか尋ねるダイアログ・ボックスを表示します。次に示す画像は、
netCDFファイルを開こうとしている例です。netCDFは、その様々な記法に対して
ParaViewが複数の読込みオブジェクトを持っている汎用ファイル形式です。

データのフィルタリングに進む前に、データの表現方法の幾つかを簡単に見てお
きましょう。データの表現に関する最も一般的な設定は、2つのツールバーに配置
されています (これらはプロパティ・パネルのDisplayグループでも確認することが
できます)。

Toggle Color 
Legend

Mapped
Variable Representation

Vector
Component

Edit
Colors

Reset Scalar
Range

Custom Scalar
Range

演習 2.6: 表現方法とフィールド・データによる色付け
データの表現方法を幾つか試してみましょう。パイプライン・ブラウザで、disk out

ref.ex2が選択されていることを確認して下さい (もし、まだデータを読込んでいな
ければ、演習 2.5の手順を行って下さい)。変数選択 (上図のMapped Variable) を
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使用して、表面を Pres変数で色付けしてみて下さい。次に色の凡例表示 (上図の
Toggle Color Legend) をオンにして、実際の圧力の値を見てみて下さい。メッシュ
の構造を見るには、表現方法 (上図のRepresentation) を Surface With Edgesにしま
す。Wireframe表現にすると、セル構造とメッシュの内部の両方を見ることができ
ます。

♦

2.4 フィルタ
これまでのところ、とりあえずはデータの読込みに成功し、そのデータの情報を

幾らか見ることができました。つまり、メッシュの基本的な構造を表示し、メッシュ
の表面に何らかのデータをマッピングできるようになりました。しかしながら、こ
れから見るように、データの表面をただ眺めるだけでは判らない興味深い特徴が、
このデータには多数あります。(スカラーやベクトルのような) 異なった型の多くの
変数が、このメッシュには関連づけられています。さらに、メッシュはソリッド (中
実) なモデルであることに注意して下さい。興味深い情報の多くは、内部に存在し
ています。
フィルタを適用することで、データに関してさらに多くのことを発見できます。

フィルタとは、データを処理して、データから特徴を生成、抽出、または導出するた
めの機能ユニットです。フィルタは読込みオブジェクト、ソース、あるいは他のフィ
ルタに接続され、それらのデータに対し何らかの形で変更を加えます。これらの互
いに接続されたフィルタによって、可視化パイプラインが形成されます。ParaView

では、非常に多数のフィルタが利用可能です。以下は対応するフィルタ・ツールバー
上のアイコンをクリックすることで利用できる、最も一般的なフィルタです。
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Calculator (電卓) 格子点またはセル毎に、ユーザによって定義された数式を
評価します。

Contour (コンター) スカラー場がユーザによって指定された値に等しくなる
ような点、曲線、面を抽出します。この面は等値面とも呼ばれます。

Clip (クリップ) 形状を半空間で切断します。その結果、ユーザによって定義
された面のいずれか一方の側の形状が削除されます。

Slice (スライス) 形状を面で切断します。その結果はクリップと同様ですが、面
上の形状だけが残されます。

Threshold (しきい値) スカラー場の指定された範囲に存在するセルを抽出し
ます。

Extract Subset (サブセットの抽出) 抽出すべきボリュームあるいは間引き率
を指定し、格子のサブセットを抽出します。

Glyph (グリフ) グリフ、すなわち単純な形状をメッシュの各格子点に配置し
ます。グリフはベクトルによって方向を指定し、ベクトルまたはスカラーに
よってスケーリングすることができます。

Stream Tracer (流線追跡) ベクトル場にシード点を配置し、(定常の)ベクト
ル場をそれらのシード点から追跡します。

Warp (vector) (ワープ (ベクトル)) メッシュの各格子点を、与えられたベク
トル場で変形させます。

Group Datasets (データセットのグループ化) 複数のパイプライン・オブジェ
クトの出力を、一つのマルチブロック・データセットに統合します。

Extract Level (レベルの抽出) マルチブロック・データセットを構成する要素
(ブロック) を抽出します。

これらの 11種のフィルタは、ParaViewで利用可能なもののご
く一部の例です。Filtersメニューには、データ処理のためのフィル
タがさらに多数存在します。ParaViewからは現在のところ 100以
上のフィルタが利用可能であるため、簡単にフィルタを見つけら
れるよう、Filtersメニューは以下のようにサブメニューに整理さ
れています。

Recent (最近使ったフィルタ) 最も最近使われたものが一番上に来るようソートさ
れた、最も最近使われたフィルタのリストです。
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AMR (解適合格子) 解適合格子 (AMR)構造のデータの向けに設計されたフィルタ
のセットです。

CTH CTHによるシミュレーションの結果を処理するのに適したフィルタです。

Common (一般的) 最も一般的なフィルタです。これはフィルタ・ツールバーにリ
ストされているフィルタと同じで、前述のとおりです。

CosmoTools (宇宙ツール) これには、LANL (ロスアラモス国立研究所) で開発さ
れた、宇宙論に関する研究のためのフィルタが含まれます。

Data Analysis (データ分析) 定量的な値をデータから取り出すためのフィルタで
す。これらのフィルタはメッシュ上でデータを計算したり、メッシュから要素
を抽出したり、データをプロットするのに使用します。

Material Analysis (材質解析) 材質の体積分率のデータを処理するためのフィル
タです。

Quadrature Points (求積点) 積分点として与えられるシミュレーション・データ
を補助するフィルタで、ガウス求積法による数値積分のために使用することが
できます。

Statistics (統計) ここには、データの統計値を計算するフィルタが含まれます。そ
れらは、基本的には表形式で表現されます。

Temporal (時間依存型) 時間によって変化するデータを分析、あるいは加工する
フィルタです。全てのフィルタは各時刻のスナップショットに対して実行され
るため、時間によって変化するデータに対して使用可能です。しかしながらこ
の分類のフィルタは特に、利用可能な時間範囲を走査し、データが時間ととも
にどのように変化しているかを調べることができます。

Alphabetical (アルファベット順) 全ての利用可能なフィルタのアルファベット順
のリストです。あるフィルタがどこにあるか判らなければ、このリストには確
実に存在します。また、このリストにしか存在しないフィルタも多数存在し
ます。
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これらのフィルタの一覧、特にアル
ファベット順の全フィルタのリストはあ
まりに多く、目的のフィルタを探すのは
面倒です。フィルタを素早く選ぶには、
クイック起動ダイアログを使用して下さ
い。Windowsおよび LinuxではCtrlと
Spaceキー、MacintoshではAltとSpace

キーを同時に押すと、ここで示すような
小さなダイアログボックスが現れます。
フィルタ名に含まれる単語、またはその
一部を入力すると、その入力した語を含
むソースとフィルタが一覧表示されま
す。目的のフィルタまたはソースを選択し、Enterキーを押すと、それがパイプライ
ン・ブラウザに追加されます。ESCキーを 2、3回押すとダイアログをキャンセルす
ることができます。
フィルタの一部はメニュー上でグレーになっていて、選択できないことにお気づ
きかと思います。特定の型のデータにしか適用できないため、常に使用できる訳で
はないフィルタも多数あります。ParaViewはそのようなフィルタをメニューおよび
ツールバーから選択不可にし、それらのフィルタが使用不可であることを示し (ま
た、それを強制的に使用できないようにし) ます。
このチュートリアルでは多くのフィルタを使用しますが、それでも全てを試せる
訳ではありません。それぞれのフィルタのさらなる情報については、ParaViewのオ
ンラインヘルプ、もしくは内蔵のヘルプのフィルタ・メニューの章をご覧下さい。

演習 2.7: フィルタを適用する
それでは最初のフィルタを適用しましょう。disk out ref.ex2がまだ読込まれていな
ければ、ここで読込んで下さい (演習 2.5)。パイプライン・ブラウザ上で disk out

ref.ex2が選択されていることを確認し、フィルタ・ツールバーまたはFiltersメニュー
から、Contour フィルタを選択して下さい。パイプライン・ブラウザの読込みオ
ブジェクトの下に新たな項目が追加され、プロパティ・パネルにフィルタの設定画
面が表示されます。ファイルの読込みと同様に、フィルタの適用も 2段階の操作で
す。フィルタの作成後、フィルタの適用前に設定を変更することができます (そし
てそれはほぼ大抵の場合、必要な操作です)。
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Change to Temp 

Change to 400 

コンター・フィルタを使って、温度が 400 Kの等値面を作成することにしましょ
う。まず、Contour Byの設定をTemp変数に変更します。つぎに、等値面の値を 400

に変更します。最後に、 をクリックしてください。等値面がボリュームの
内部に現れる筈です。もし disk out ref.ex2が演習 2.6のとおりに圧力で色付けされ
たままであったら、等値面も同様に圧力で色付けされます。

♦

以上の演習では、フィルタを使ってデータを加工し、必要な結果を得る方法を学
んで来ました。ほとんどの一般的な処理では、単一のフィルタで必要な情報を得る
ことができます。しかしながら、フィルタは読込みオブジェクトと同種のオブジェク
トです。すなわち、読込みオブジェクトに対して適用するような操作を、フィルタ
に対しても適用することができます。それはつまり、あるフィルタによって生成さ
れたデータに対して、さらにフィルタを適用することができるということです。こ
れらの一連の互いに接続された読込みオブジェクトとフィルタを、可視化パイプラ
インと呼びます。この可視化パイプラインを形成する機能は、要求に合わせてデー
タの可視化を行うための強力な仕組みです。
もう少し、フィルタを色々試してみましょう。内部にあるものの表示をしばしば

妨げるメッシュ表面のワイヤフレーム表示の代わりに、表面の一部を切り取った状
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態にしましょう。この操作には 2つのフィルタが必要です。すなわち、1つ目のフィ
ルタで表面を抽出し、2つ目で表面の一部を切り取ります。

演習 2.8: 可視化パイプラインの作成
この演習の画像および議論のいくつかは、演習 2.7を終えた直後の状態からこの演
習を始めることを前提としています。もし ParaViewを再起動していたり、その他
の理由で異なる状態にある場合は、たんに disk out ref.ex2を読込めば充分です。
それでは表面を抽出するフィルタを追加しましょう。それは以下の手順で行います。

1. パイプライン・ブラウザで disk out ref.ex2を選択します。

2. メニューバーから Filters → Alphabetical → Extract Surfaceを選択します。 も
しくはクイック起動 (Windows/LinuxではCtrl+Space、MacではAlt+Space)

を呼び出して、extract surfaceと入力し、そのフィルタを選択して下さい。

3. ボタンをクリックしてください。

Extract Surfaceフィルタを適用すると、再びメッシュの表面が見えるようになり
ます。元のメッシュと同じように見えますが、元のデータが中実なのに対し、この
データは中空である点で異なっています。
コンター・フィルタの結果を表示させていた場合は、コンターが見えなくなりまし
たが、心配する必要はありません。表面に隠されているだけで、依然としてそこに
存在しているからです。もしフィルタの適用後の表示に何も変化が無ければ、1番目
の disk out ref.ex2を選択する操作を忘れて、違うオブジェクトにフィルタを適用し
てしまった可能性があります。もし ExtractSurface1オブジェクトが disk out ref.ex2

に直接接続されていなければ、それが間違えた操作です。もしそのとおりであれば、
フィルタを削除して再度適用を試みてください。
それでは表面を切り取って、(もし存在すれば) 内部の構造と等値面が見えるよう
にしましょう。

4. パイプライン・ブラウザ上で、ExtractSurface1が選択されていることを確認し
ます。
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5. ツールバーもしくは Filtersメニューから、クリップ・フィルター を選択し
てください。

6. プロパティ・パネルの Show Planeチェックボックス から、チェッ
クを外してください。

7. ボタンをクリックしてください。

もしコンターを作成していたのであれば、メッシュ表面を切り取った内側から、等
値面コンターが見える筈です。コンターがはっきり見えるためには、メッシュを回
転させる必要があるかもしれません。 ♦

disk_out_ref.ex2 

Contour1 ExtractSurface1

Clip1 

パイプラインにフィルタが幾つか追加されましたので、パイプライン・ブラウザ
でのこれらのフィルタの配置を見てみましょう。パイプライン・ブラウザによって、
今までに作成されたパイプライン・オブジェクトは判りやすいリストになっていま
す。これによって簡単にパイプライン・オブジェクトを選択し、それらのオブジェ
クトの隣にある目のアイコン をクリックして表示・非表示を変更することがで
きます。しかしさらに、このリスト中の項目のインデントと、インデントを辿って
左側へ折れ曲がった線にも注目して下さい。これらの機能はパイプラインの連結状
態を示しています。これは右の図の従来型のグラフと同じ情報を、ずっとコンパク
トなスペースで表現しています。パイプライン・オブジェクトの従来型配置の問題
点は、多くのスペースが必要であり、さほど大規模でないパイプラインでさえ完全
に見渡すにはGUIの大部分が必要なことでした。しかし、このパイプライン・ブラ
ウザは、完全でありながらコンパクトです。
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2.5 複数ビューの利用
科学上の目的で時折、1つの変数に絞って検討することがあります。しかし、多く
の重要な物理現象は、互いに何らかの影響を与え合う複数の変数で記述されます。そ
れゆえ、1つの視点で多くの変数を表示するのは大変難しいといえます。ParaView

はデータを多様な視点で表示し、それらを相互に関連付ける機能を持っており、そ
のような機能は複雑な可視化データを考察する上で有用です。
今までのところ、可視化では 2つの変数に注目しています。すなわち、圧力を色
のグラデーションで表し、温度による等値面を抽出して表示しています。一見、2つ
の変数をきれいに配置できているようにも見えますが、それらを分かりやすく関連
付けることはできていません。複数の視点を使うことで、両者の関係を分かりやす
くすることができます。各視点がデータの個別な特徴を表示し、さらにそれらを組
み合わせることで、より理解しやすい可視化とすることができます。
各ビューの上部には小さなツールバーがあり、このツールバーの右側にビューを
作成したり、削除するためのボタンがあります。全部で 4つのボタンがあります。
もしくは ボタンを押すことで、既に存在するビューをそれぞれ水平もしくは垂
直に分割して新たなビューを作成することができます。 ボタンによってビューは
削除され、そのビューによって占められていたスペースは隣接するビューで占めら
れます。 ボタンによって、選択したビューを一時的にビュー画面いっぱいに拡大
して表示することができ、 で元の状態に戻ります。

演習 2.9: 複数ビューの利用
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。それを行う最も簡単な方法は、メニューからEdit → Reset

Session を選ぶことです。このオプションによって現在作業している全ての内容が削
除され、ParaViewはリセットされて初期状態に戻ります。これは、ParaViewを再
起動するのと概ね同等であると理解しておいて下さい。
まず最初に、1つの変数に着目します。メッシュの中にある変数を見たいので、メッ
シュを半分にクリップしましょう。

1. disk out ref.ex2ファイルを開き、変数を全て読込んで をクリックし
てください (演習 2.5を参照して下さい)。

2. disk out ref.ex2にクリップ・フィルタ を適用してください。

3. プロパティ・パネルの Show Planeのチェックボックス からチェッ
クを外して下さい。

4. ボタンをクリックしてください。

5. (ツールバーの) 変数選択を、Solid Colorから圧力 Presに変更し、表面を色付
けします。
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メッシュ内部の平面の圧力分布が見えるようになりました。ここでさらに、同じ
平面の温度分布と比較したいとします。そのためには、新しいビューを作成するこ
とで、もうひとつの可視化を行うことができます。

6. ボタンをクリックしてください。

現在の画面は半分に分割され、右側には何も表示されていません。この何も表示
されていない部分に、新しく可視化を表示します。右の画面には、周囲に青い境界線
が表示されていることに注目してください。これはアクティブなビューであること
を示しています。パイプライン・ブラウザやプロパティ・パネルなどの、あるビュー
の情報を表示したり、各種設定を制御するウイジェットは、アクティブなビューに
ついてそれらを行います。この新しいビューには、メッシュの温度分布を表示させ
ます。

7. 青い境界線が、(右側の) 新しい空白のビューの周囲に表示されている状態に
してください。どのビューでもクリックすることで、アクティブなビューにす
ることができます。

8. パイプライン・ブラウザのClip1の隣にある目のアイコン をクリックして、
クリップしたデータの表示をオンにしてください。

9. パイプライン・ブラウザ上で Clip1を選択し、(ツールバー内の) 変数選択で変
数を Solid Colorから Tempに変更し、表面を温度分布で色付けしてください。
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画面に 2つのビューができました。1つは圧力の情報を、もう 1つは温度の情報
を表示しています。これらを比較したいところですが、2つの画面の視点方向が違
うために困難です。どのようにして、一方の視点位置をもう一方の始点位置と連動
させることができるでしょうか？この問題を解決するには、カメラのリンクを使い
ます。カメラのリンクを使うことで、2つの画面は常に同じ視点から描画されます。
カメラのリンクは簡単にできます。

10. いずれかのビューの上で右クリックし、ポップアップメニューからLink Camera...

を選択してください。(もしMacを利用していてマウスに右ボタンがない場合、
Tools → Add Camera Link...のメニューオプションを選択することで同様の操
作が可能です。)

11. もう一方の画面をクリックしてください。

12. それぞれの画面でカメラを動かしてみて下さい。

やった！2つのカメラがリンクされました。どちらのカメラも、もう一方を追随
して動きます。カメラがリンクされると、2つの画面を比較して見ることができま
す。 ボタンをクリックして、視点を断面をまっすぐに見る位置にしてください。

空気温度が、熱せられた円盤との接触面で最大となっていることがわかります。
それ自体は、驚くことではありません。空気温度が熱源近くで最大となり、離れる
に従って低くなっていくことは予想されます。しかし、同じ地点で圧力が最大では
ないことに注目してください。空気の圧力は、円盤の上空で最大値を取っています。
この情報を基に、この物理的現象にいくつかの興味深い仮説を立てることができま
す。空気の圧力分布には、2つの力が関係していることが考えられます。1つ目の力
は重力による力で、上方の空気が下方の空気を押さえつける働きをします。2つ目
の力は浮力で、熱せられた空気が密度が小さくなることで上方に昇ろうとする力で
す。空気の圧力が最大値を取る位置から、これらの 2つの力が釣り合う点が判りま
す。このような考察は、温度と圧力の両方を同時に見なければできないでしょう。♦

もちろんParaViewの複数視点の機能は、同時に 2つ以上の視点も表示できます。
各々のビューには 1セットずつ、複数視点の為の分割ボタンがあります。ビュー分
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割ボタン を使うことでさらにビューを作成し、ワークスペースを分割するこ
とができます。そして分割したビューは、 ボタンでいつでも削除することができ
ます。
各ビューの表示位置も固定ではありません。ビューのツールバー上 (ボタンでな

い部分) をクリックし、マウスのボタンを押したまま別のビューのツールバー上に
ドラッグすることで、2つのビューの表示位置を入れ替えることができます。この
操作によって、2つのビューは即座に入れ替わります。

2つのビューの間をクリックし、マウスのボタンを押したままどちらか一方のビュー
の方向にドラッグすることで、ビューのサイズを変更することもできます。ビューの
境界はマウスの動きに従って動き、ビューの大きさもそれに合わせて調整されます。

2.6 ベクトルの表示
このシミュレーション結果から、他にどのような結論を導けるでしょうか。シミュ

レーションは、熱せられた回転円盤上の空気の流れを表す速度場も算出しています。
ParaViewを使って、空気の流れを確認します。
ベクトル場を描画するための一般的で効率的な方法は、流線を使用することです。

流線とは、あらゆる点でベクトル場に沿っている空間中の曲線です。流線はまた、無
重量の粒子がベクトル場で取る経路を表します (流れが定常である場合)。 流線は、
シード点を与えることで生成されます。
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演習 2.10: 流線
新たな可視化を始めますので、ここまでの演習を行っていた場合は、メニューから
Edit → Reset Sessionを選択しましょう。

1. disk out ref.ex2ファイルを開き、変数を全て読込んで をクリックし
てください (演習 2.5を参照して下さい)。

2. 流線追跡フィルタ を disk out ref.ex2に適用してください。

3. ボタンをクリックして、デフォルトの設定を適用します。

メッシュの表面が、渦巻いた線に置き換えられました。これらの線は、ボリュー
ムを通る流れを表しています。円筒の中心軸周りに、渦のような流れができている
ことに注目してください。中心や端部周辺には、垂直方向の流れもあります。
新しい形状は、元々あった形状と中心がずれています。カメラのリセット コ
マンドを使うことで、新しい形状の視点を即座に中心に移動させることができます。
このコマンドは、表示されている形状を現在のビューに収め、中心を移動させると
共に、カメラの回転の中心を表示されている形状の中心に一致させます。 ♦

流線の問題の 1つは、現在表示されている状態がそうであるように、多くの線が
互いに接するように表示され、また陰影もないため、線同士の見分けがつかないこ
とです。線は 1 次元で、陰影を表現するには 2次元の面を必要とするからです。流
線のもう 1つの問題は、流れの方向がわからないことです。
次の演習では、演習 2.10で作成した流線を修正して、これらの問題を解決してい
きます。チューブ・フィルタを使うことで、流線の周りに 2次元の面を作成すること
ができます。この面によって、流線に陰影と距離感の手がかりが付加されます。更
に流線に矢印を追加することで、流れの方向を示すこともできます。

演習 2.11: 流線を見やすくする
この演習は演習 2.10の続きです。こちらを始める前にまずそちらの演習を終了する
必要があります。
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1. クイック起動 (Windows/Linuxでは Ctrl+Space、Macでは Alt+Space)を使
用して、流線に Tubeフィルタを追加します。

2. ボタンをクリックしてください。

流線が鮮明に見えるようになりました。流線を横方向から眺めてみると、気流の
循環を見ることができます。空気が熱せられ上昇し、冷えると下降しています。流
線を回転させてZ軸を見下ろすようにし、熱せられた円盤がある筈の辺りを見ると、
回転する円盤との摩擦によって空気が円形に流動しているのが分かります。
もう少し、装飾を施してみましょう。流線に矢印を加えることで、流れの方向と

大きさを示すことができます。

3. パイプライン・ブラウザで StreamTracer1を選択してください。

4. StreamTracer1にグリフ・フィルタ を加えてください。

5. プロパティ・パネルで、Glyph Typeの設定を Coneに変更してください。

6. プロパティ・パネルで、Vectorsの設定を Vに変更してください。

7. 少し下にスクロールして、Scale Modeを vectorに変更してください。

8. Scale Factorの横のリセット ボタンをクリックしてください。

9. ボタンをクリックしてください。

10. 矢印をTemp変数で色付けしてください。
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このようにして、流線に小さな矢印が追加されました。矢印の向きは速度の方向
を示し、大きさは速度の大きさに比例しています。この新たな情報を利用して、次
の問題に答えてみましょう。

• 空気が一番速く流れているのは、どこでしょうか？円盤の近く、もしくは離れ
ているでしょうか？円盤の中央付近か、それとも周縁付近でしょうか？

• 円盤の回転の向きは、どちらでしょうか？

• 円盤表面では、空気は円盤の中心に向かって流れていますか、それとも周縁部
分に向かって流れていますか？

♦

2.7 プロット
ParaViewのプロット機能によって、データを掘り下げ、定量的な解析を行うこと
が可能になります。プロットは通常、フィルタによって作成され、プロットを作成
するためのフィルタは、全て Filtersメニューの下のData Analysisサブメニューにあ
ります。またデータ解析ツールバーには最も一般的なデータ解析フィルターがあり、
そのうちのいくつかはプロットの生成に使用されます。

Extract Selection (抽出選択) オブジェクトから選択されたデータを抽出し、
抽出されたデータからなる新たなオブジェクトを作成します。選択について
は、2.12節に記載があります。

Plot Global Variables Over Time (グローバル変数を時間に沿ってプロット)

データ・セットには、1つの点やセルでなはくデータ・セット全体に適用され
る “グローバルな”変数の情報が保存されていることがあります。このフィル
タは、グローバルな情報を時間に沿ってプロットします。ParaViewでの時間
の取り扱いについては、2.9 節に記載があります。

Plot Over Line (直線に沿ってプロット) 3D空間内に線分を定義し、フィー
ルド情報をその直線にそってプロットします。

Plot Selection Over Time (選択データを時間に沿ってプロット) 選択され
た点、またはセルのフィールドを取得し、その値を時間に沿ってプロットしま
す。選択については 2.12節に、時間については 2.9節に記載があります。

Probe (探査) 空間内の特定位置におけるフィールドの値を取得します。

次の演習では、空間内の線分上におけるメッシュ中のフィールドの値をプロット
するフィルタを作成してみましょう。
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演習 2.12: 空間中の線分上の値をプロットする
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. disk out ref.ex2ファイルを開き、変数を全て読込んで をクリックし
てください (演習 2.5を参照して下さい)。

2. (演習 2.9のように) disk out ref.ex2にクリップ・フィルタ を適用し、プロ
パティ・パネルの Show Planeのチェックボックス からチェック
を外し、 をクリックして下さい。これによって、値をプロットする
ための線分が見やすく、また操作しやすくなります。

3. パイプライン・ブラウザで disk out ref.ex2をクリックし、アクティブなオブ
ジェクトにして下さい。

4. ツールバーから直線に沿ってプロット フィルタを選択します。

アクティブなビューに、両端に球の有る線分が、表示されているデータを貫く形
で描画されます。これらの球のどちらかをマウスでドラッグすることで、3Dビュー
内を移動させることができます。画面内の球を動かすたびに、プロパティ・パネル
の項目の幾つかも変化することにも注目して下さい。目的の場所にマウスポインタ
を移動させ、pキーを押すことでも球を移動させることができます。この場合、マ
ウスポインタの位置に存在する面に、球を順次移動させることになります。これが
クリップ・フィルタを使用した目的で、これによってクリッピング面に端点を置く
ことができます。この方法で球を移動させることができるのは、ソリッドにレンダ
リングされた面に対してのみであることに気をつけてください。ボリューム・レン
ダリング 2や半透明面に対しては、この方法は使えません。
この線分と球などの表現は 3Dウィジェットと呼ばれています。なぜなら、これ

は 3次元空間内で操作されるGUIコンポーネントだからです。ParaViewには、多
くの 3Dウィジェットの例があります。特にこのライン・ウイジェットは、空間内で

2訳注: ボリューム・レンダリングについては、次節で説明します。
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線分を指定するのに使用されます。他にも、点や面を指定するためのウィジェット
があります。

5. 線分が円盤の基部からメッシュ全体の頂部へ垂直に結ばれるように、3Dウイ
ジェットを操作するか、pキーを押すか、もしくはプロパティ・パネルで数値
指定をして調整してください。

6. 線分を目的の位置に配置できたら、 ボタンをクリックします。

プロットの際に行える操作がいくつかあります。マウスのホイールを上下に回転
すると、拡大・縮小を行う事ができます。中央ボタンでドラッグすると、ドラッグ
範囲へのズームができます。左ボタンでドラッグすると、プロット画面をスクロー
ルすることができます。 コマンドを使うことで、プロットの範囲が収まるよう
ビューを再設定することもできます。 ♦

3Dレンダリングと同様に、プロットはビューであると考えられます。どちらも
別々の方法によってではありますが、データの表現方法を提供しています。そのた
め、3Dビューと同様の操作をプロットに対して行うことができます。プロパティ・
パネルのDisplayセクションを見ると、色、線のスタイル、ベクトル成分、凡例など、
この表現に関する様々な設定があることがわかります。

さらにプロパティ・パネルのViewセクションまで下にスクロールすると、ラベル、
凡例、軸の数値範囲など、プロット全体の設定を変更することもできます。
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他のビューと同じように、File → Save Screenshotを選ぶことで、プロットの
画像を保存することができます。さらに File → Export Scene...を選ぶと、印刷用画
像に適した拡大縮小が可能なベクター画像としてファイルをエクスポートすること
ができます。これらの画像保存機能については、後ほど 2.11節で説明します。また
他のビューと同様に、GUI上のプロットをサイズ変更したり、入れ替えたりするこ
ともできます。
次の演習では、表示を変更して、プロットからより多くの情報を引き出します。特

に、プロットを使って、圧力と温度の値の比較を行います。

演習 2.13: 一連のプロットの表示設定
この演習は演習 2.12の続きです。この演習を始める前に、演習 2.12を完了させて下
さい。

1. GUI上でプロットを移動させたい場所を決め、分割、削除、サイズ変更、位置
の変更を使って、プロットをその場所に移動させます。

2. プロットをアクティブな状態にし、プロパティ・パネルのDisplay セクション
へ移動してから、Tempと Pres以外の変数を全てオフにします。

Tempと Presの変数は、異なる単位を持ちます。この 2つを同じスケールで比べ
るのは、有用ではありません。したがって、同一のプロット上で各変数を各々のス
ケールで表示し、比較することとなります。ParaViewの直線プロットでは、左軸と
右軸それぞれに異なったスケールを設定することができ、各変数を別々の軸にした
がってスケールさせることができます。

3. Display設定から Pres変数を選択します 3。

4. Chart Axesを Bottom - Rightに変更します。

3訳注: Pres変数の行の左端のチェックボックス以外の部分をクリックして、スクリーンショット
のように Pres変数の行をハイライトします。
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このプロットから、2.5節で行った考察が正しいことが確認できます。温度がプ
レートの表面で最大値を取り、そこから離れるに従って下がるのに対し、圧力は少
し上昇してから下降し始めます。さらに、圧力が最大値をとるのは (そして、空気
中で力が釣り合うのは) おおよそ 3単位長さだけ離れた位置であることもわかりま
す。 ♦

ParaViewは、任意の数の異なった種類のビューに対応しています。これによって
研究者や開発者は、新しい視点でデータを見ることができます。さらにもう一つの
ビューの例を示すために、パイプライン・ブラウザの disk out ref.ex2を選択し、さ
らに Filters → Data Analysis → Histogram を選択してみましょう。温度のヒスト
グラムを作成し、 ボタンをクリックします。

2.8 ボリューム・レンダリング
ParaViewには、データの表現方法がいくつかあります。サーフェス、ワイヤフレー
ム、およびそれらの組合せといった、いくつかの例を既に見てきました。ParaView

はさらに、データセット表面上の点、もしくは単純にバウンディング・ボックスを
表示することもできます。
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点 ワイヤフレーム サーフェス サーフェスと
エッジ

ボリューム

それら表現方法の中でもボリューム・レンダリングは、ParaView上でデータを表
現する上で強力なテクニックです。ボリューム・レンダリングでは、中実なメッシュ
が、メッシュ内の各点における色と濃度を表すスカラー場によって、半透明の雲のよ
うな塊としてレンダリングされます。サーフェス・レンダリングとは違い、ボリュー
ム・レンダリングでは、ボリュームを通してデータセット内部の特徴に至るまで把
握することができます。
ボリューム・レンダリングは、オブジェクトの表現方法を変更することで簡単に

実現できます。温度の表示をボリューム・レンダリング表示に変えてみましょう。

演習 2.14: ボリューム・レンダリングをオンにする
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. disk out ref.ex2ファイルを開き、全ての変数を読み込み、 をクリッ
クしてください (演習 2.5参照)。

2. パイプライン・ブラウザ上で、disk out ref.ex2が選択されていることを確認し
てください。表示される変数をTempに、表現方法を Volumeにそれぞれ変更
します。
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不透明なメッシュの代わりに、半透明なボリュームが表示されました。オブジェ
クトを回転させる際に、パフォーマンスの関係でその描画が一時的に簡単な半透明
の面に置き換えられます。この動作についての詳細は後ほど、3章で説明します。♦

ParaViewのボリューム・レンダリングの便利な点は、他のオブジェクトのサーフェ
ス・レンダリングと同時に使用できることです。これによって対象のボリューム・レ
ンダリングの周囲の状況を再現したり、また他の表示と組み合わせることで、より
多くの情報を伝えることができます。例えば、温度のボリューム・レンダリングを、
演習 2.10で行ったような流線ベクトルの可視化と組み合わせることができます。

演習 2.15: ボリューム・レンダリングとサーフェス表現の可視化を組
合わせる
この演習は演習 2.14の続きです。この演習を始める前に、演習 2.14を完了させて下
さい。

1. 流線追跡フィルタ を disk out ref.ex2に追加します。

2. ボタンをクリックして、デフォルトの設定を適用します。

これで、ボリューム・レンダリングの中に、流線が埋め込まれているのが見える
筈です。以下の追加の操作によって、演習 2.11でのように、流線に形状を追加して、
流線を見やすくすることができます。これらは必須ではありませんので、省略する
こともできます。

3. クイック起動 (Windows/Linuxでは Ctrl+Space、Macでは Alt+Space)を使
用して、Tubeフィルタを適用し、 をクリックします。

4. 流線が Tempで色付けされていれば、Solid Colorに変更します。

5. パイプライン・ブラウザで、StreamTracer1を選択します。

6. グリフ・フィルタ を StreamTracer1に追加します。

7. プロパティ・パネルで、Glyph Typeの設定を Coneに変更します。

8. プロパティ・パネルで、Vectorsの設定を Vに変更します。

9. 少し下にスクロールして、Scale Modeを vectorに変更します。

10. Scale Factorの横のリセット ボタンをクリックします。

11. ボタンをクリックします。

12. Temp変数によってグリフを色付けします。
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これで、流線がボリューム全体に渡って温度場の中に表示されました。 ♦

デフォルトでは、ParaViewはサーフェス・レンダリングで使われているのと同じ
色を、値の範囲の最低値を不透明度 0、最高値を不透明度 1に設定して描画します。
ParaViewでは伝達関数 (スカラー変数を表示する際の色や不透明度に関する設定)

の変更も簡単に行えます。伝達関数エディタを使うには、ボリューム・レンダリン
グされたパイプライン・オブジェクト (今回の例では disk out ref.ex2)を選択した状
態で、カラーマッピングの編集 ボタンをクリックします。

初めてカラー・マップ・エディタを起動した時には、ParaView GUIウィンドウの
右側に表示されます。ParaViewのパネルのほとんどと同じ様に、ドッキング可能な
ウィンドウなので、GUIの周囲を移動させたり、分離してデスクトップの別の位置
に配置することができます。プロパティ・パネルと同様、ユーザ・インターフェイ
スをシンプルにするために、高度な設定のいくつかは非表示になっています。これ
らの非表示になっている機能を使うには、右上についた ボタンで切り替えるか、
検索文字列を入力します。
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上部の色がついた 2つのボックスは、伝達関数を表しています。下側に色のつい
た関数プロットが表示されている 1つ目のボックスは、透明度を表し、下の長細い
ボックスは色を表しています 4。伝達関数上の丸い点は、制御点を表しています。制
御点とは特定のスカラー値に設定された色と不透明度のことであり、制御点間の色
と不透明度は補間値が与えられます。バー上の空白部分をクリックすると、新しい
制御点が作成されます。既に有る制御点上でクリックすると、その点を選択します。
選択された制御点を、ボックスの中でドラッグすることでスカラー値と透明度を変
更できます。色制御点をダブルクリックすると、その色を変更できます。選択され
た制御点は、BackspaceキーもしくはDeleteキーを押すと削除されます。
カラーと透明度のバー直下には、テキスト入力ウィジェットがあり、選択された制
御点のDataの数値を指定できます。その下にはUse log scale when mapping data to

colors (データから色のマッピングで対数スケールを使用)、Enable opacity mapping

for surfaces (表面への透過マッピングを有効にする)、Automatically rescale transfer

functions to fit data (データに合わせて伝達関数を自動で再スケール) というチェッ
クボックスがあります (このうち最後のものを使うと、データ変更を伴うほとんど
の操作でデータ範囲がリサイズされるようになりますが、時刻が変更された時には
行われません。詳しくは、2.9節をご覧下さい)。
その下のColor Spaceパラメータによって、色の補間方法が決まります。このパラ
メータは制御点の色には影響しませんが、制御点の間の色に大きく影響します。最
後に、Nan Colorによって、無効値に割当てる色を選択することができます。NaN

は、(0/0の演算結果などの) 非数を表現するための特別な浮動小数点値です。
伝達関数の設定は面倒になりがちですので、Save to preset ボタンをクリック
することで設定を保存することができます。Choose preset ボタンによって現れ
るダイアログでは、作成したカラー・マップや、ParaViewに最初から用意されてい
るカラー・マップを、管理および適用することができます。

演習 2.16: ボリューム・レンダリングの伝達関数を変更する
この演習は、演習 2.15の続きです。この演習を始めるには、演習 2.15 (または、少
なくとも演習 2.14) を完了させて下さい。

1. パイプライン・ブラウザの disk out ref.ex2をクリックし、アクティブにします。

2. カラー・マップの編集ボタン をクリックします。

3. ボリューム・レンダリングを、さらに熱の表現にふさわしくします。Choose

preset をクリックし、ダイアログ・ボックスからBlack-Body Radiationを選
択し、Closeをクリックします。

4原注: サーフェス・レンダリングでは “Enable opacity mapping for surfaces”が有効になってい
ない限り、透明度コントロールは表示に影響を与えません。
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4. 制御点を追加・変更し、それらのボリューム・レンダリングへの影響を観察し
てください。Updateをクリックするか、自動更新 を有効にして、加えた
変更によってどのような結果が得られるかを確かめてください。

ボリューム・レンダリングのカラー・マッピングのみならず、全てのビューでの
Tempのカラー・マッピングが変更されていることに注意してください。もし矢印を
作成している場合には、それも含まれます。これによってビュー同士の一貫性を保
証し、同じ変数を違う色や違う値の範囲でマッピングしてしまうことによる混乱を
避けることができます。 ♦

2.9 時間
ここまで disk out refのシミュレーションを余すところなく分析して来ましたの

で、次は新しいシミュレーションに進んで、ParaViewがどのように時間を扱ってい
るのかを見てみましょう。この節では、簡単なシミュレーションによる、時間によ
る変化のある新たなデータセットを使用します。

演習 2.17: 時間情報を持つデータを読み込む
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. Openメニューから、can.ex2を開きます。
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2. 先程と同じように、変数リストの最上部のチェックボックスをクリックして、
全ての変数が読み込まれるようにし、 ボタンを押します。

3. ボタンを押して、カメラをメッシュに向けます。

4. 再生ボタン を押して、落下するレンガによって缶が潰れる様子のメッシュ
が、ParaViewによってアニメーションされる様子を見てみましょう。

♦

時間変化するデータを扱う際にすることは、これだけです。ParaViewには時間の
概念が組み込まれていて、データ内の時間と自動的にリンクするようになっていま
す。時間を扱うためのツールバーに慣れてください。

First
Frame

Previous
Frame Play

Next
Frame

Last
Frame

Loop
Animation Current Time Current Time Step

アニメーションの保存も同様に簡単です。メニューから File → Save Animationを
選択します。ParaViewでは、ダイアログでどのようにアニメーションを保存するか
の設定ができ、そして自動的に時間を反復してアニメーションを保存します。

演習 2.18: 時間依存のデータの落とし穴
ユーザーが陥る最大の落とし穴は、値の範囲が時間変化する場合の色のマッピング
です。例を見るために、以下を行ってください。

1. 演習 2.17から続けているのでなければ、can.ex2を開き、全ての変数を読み込
む設定とし、 をクリックして下さい。

2. 最初の時刻ステップ に移動します。

3. EQPS変数で着色します。

4. アニメーションを再生 (または、最後の時刻ステップ へ移動) します。

色付けは、あまり効果を発揮していません。簡単に問題を解決するには、以下を行
います。
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5. 最後の時刻ステップにいる状態で、データ範囲にスケールを調整する ボ
タンを押します。

6. もう一度、アニメーションを再生 して下さい。

これで、色付けが効果を発揮するようになりました。 ♦

これは一見、欠陥のように見えますが、そうではありません。これは 2つの避け
がたい要因のためです。1つ目は、スカラー場の可視化を行うと、スケール範囲はそ
の時刻ステップでのデータの値の範囲に合わせて設定されます。理想を言えば、ス
ケールの範囲は、データの全ての時間を通しての最大値と最小値に設定されるべき
です。
しかしながら、それを実現しようとすると ParaViewは最初の読み込みで全ての

データをチェックすることになり、大規模データを処理する際にひどく動作が遅く
なってしまいます。2つ目は、時間を追ってアニメーションさせる際には、例えデー
タの値の範囲が変わってもスケールの範囲は固定である必要があるからです。アニ
メーションの再生に合わせて表示するスケールの範囲を変更することは、データを
誤って解釈する原因になります。スケールの範囲が暗黙に変動するよりは、当初設
定したとおりのカラー・マッピングの範囲から逸脱する方が断然良いでしょう。と
はいえ、この問題には以下のような回避方法があります。

• もし、何らかの理由でアニメーションの色の範囲が不適切となった場合は、代
表的な時刻ステップに移動して を押します。これはここまでの演習で行っ
たのと同じ操作です。

• メニューの Edit → Settings (Macでは ParaView → Preferences) から、設定ダ
イアログ・ボックスを開きます。Generalタブで、Any time a new dataset with

timesteps is opened, set the timestep the application should go to by defaultとい
うラベルがついた設定を探し、Go to last timestepへ変更します (もし見つか
らない場合は、設定の検索ボックスに timestepと入力してみてください)。こ
の項目が選択されると、ParaViewは時間を有するデータ・セットを読込むと、
自動的に最後の時刻ステップに移動します。(can.ex2のように) 多くのデータ
では、フィールド・データの範囲は最初よりも最後のデータの方が代表的な範
囲となります。したがって、読込まれてから時刻を変更する前にフィールド・
データによって色付けする限り、色の範囲は適切なものとなります。

• Rescale to Custom Data Range ツールバー・ボタンをクリックします。これ
は、“代表的な” 時刻ステップを見つけられない、または判らないか、適切な
範囲があらかじめ判っている場合に有効です。

• もし時間のかかる処理でも良ければ、エディット・カラー・マップダイアログ
上のRescale to data range over all timesteps ボタンを使うと、ParaViewは全
ての時間にわたる範囲を算出します。この設定では、ParaViewは全時刻ステッ
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プにわたる全てのデータ・セットを読み込むことに注意してください。ParaView
が一度にメモリに保持するのは高々1時刻ステップですが、大規模なデータ・
セットにおいては、データをディスクからメモリへと引出すには長時間を要す
ることがあります。

ParaViewには、時間とアニメーションを制御する強力な設定が多数あります。こ
れらの大多数は、アニメーション・ビューを通じて利用します。メニューから、View

→ Animation Viewをクリックします。

まず、アニメーション・ビューの上部にあるウイジェットを試してみましょう (ア
ニメーション・ビューの残りの部分にあるトラックの使い方は、後の 2.13節で試す
ことにします)。アニメーションのアニメーション・モード設定は、ParaViewがど
のように再生中に時間を進めるかを定義します。3つのモードを利用できます。

Sequence (シーケンス) 開始および終了時刻を与えれば、アニメーションを決めら
れたフレーム数に等間隔に分割します。

Real Time (リアル・タイム) ParaViewは、決められた秒数の再生時間となるよ
う、アニメーションを再生します。実際のフレーム数は、フレーム間の更新時
間に依存します。

Snap To TimeSteps (時刻ステップにスナップする) ParaViewは、データで定義
された時刻ステップどおりに再生します。

時間を含んだファイルを読み込むときは常に、ParaViewは自動的にアニメーショ
ン・モードを Snap To TimeStepsに変更します。そのためデフォルトでは、データ
を読込んで、再生 を押せば、データで定義されたとおりの各時刻ステップを見
ることができます。これが最も一般的な使い方です。
それ以外の使い方は、シミュレーションの書出したデータの時刻ステップ間隔が、
可変であるときに発生します。このような場合にはおそらく、時間のインデックス
よりも、シミュレーション上の時間に従ってアニメーションを再生したいでしょう。
問題ありません。残り 2つのアニメーション・モードのうちの 1つに切り替えられ
ます。別の使い方は、再生速度を変えたい場合です。アニメーションの速度を速く
したり、遅くしたいことがあるでしょう。残り 2つのアニメーション・モードでは、
それができます。
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演習 2.19: アニメーション・モードによって、アニメーションの再生
速度を下げる
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. can.ex2を開き、全ての変数を読み込む設定とし、 をクリックします
(演習 2.17を参照)。

2. ボタンをクリックして、カメラをメッシュに向けて下さい。

3. ツールバーの再生ボタン をクリックして下さい。

アニメーションの間、ParaViewは元のデータに定義されたそれぞれの時刻ステッ
プを、ただ一度だけ読み込んで表示します。アニメーションが再生される速度に注
意して下さい。

4. もし、まだ表示させていなければ、View → Animation Viewでアニメーション・
ビューを表示させて下さい。

5. アニメーション・モードをReal Timeに変更して下さい。デフォルトでは、ア
ニメーションはデータで指定されたとおりの時間の範囲となり、再生時間は 10

秒間になっています。

6. もう一度、アニメーションを再生 します。

結果は前の Snap To TimeStepsによるアニメーションに似ていますが、今回はシ
ミュレーション上の時間に比例してアニメーションが進行し、10秒間で完了します。

7. Durationを 60秒に変更して下さい。

8. もう一度、アニメーションを再生 します。

アニメーションは明らかに、ゆっくりと再生されます。使用しているコンピュー
タでの画面更新が遅くなければ、アニメーションが前に比べて断続的になっている
ことにも気づくでしょう。これはデータセットの時間解像度を上回ったからです。♦

元のデータに起因する、断続的なアニメーションの表示は多くの場合、望ましい
挙動と言えます。データの中でまさにどれが表示されているかが分かるからです。
しかし、プレゼンテーション用にアニメーションを作りたいのなら、より滑らかな
アニメーションが求められるでしょう。
ParaViewには、このために作られたフィルタが存在します。それはテンポラル・

インターポレータと呼ばれています。このフィルタは、メッシュ座標等の位置的デー
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タおよびフィールド・データに対して、元のデータセットで定義された時刻ステッ
プの間を補間します。

演習 2.20: テンポラル・インターポレータ
この演習は、演習 2.14の続きです。この演習を始める前に、演習 2.14を完了させて
下さい。

1. パイプライン・ブラウザの can.ex2がハイライト表示されていることを確認し
て下さい。

2. Filters → Temporal → Temporal Interpolatorを選択するか、クイック起動 (Win-

dows/Linuxでは Ctrl+Space、MacではAlt+Space) を使用して Temporal In-

terpolatorフィルタを適用します。

3. をクリックして下さい。

4. ビューを分割 し、一方に TemporalInterpolator1を、他方に can.ex2を表示
し、カメラをリンクして下さい。

5. アニメーションを再生 して下さい。

テンポラル・インターポレータの出力の方が、元のデータよりも大幅にスムーズ
に再生されることがお判り頂けるでしょう。 ♦

テンポラル・インターポレータの使用によって、不自然な結果を招きうる (そして、
それは実際、しばしば起きる)ことは指摘しておく必要があるでしょう。ParaViewが
この種の補間を決して自動的に行わないのはそれが理由であり、Temporal Interpolator

は明示的に適用する必要があります。また、一般的には、メッシュの変形は多くの
場合上手く補間されますが、静止したメッシュの下で移動する場は上手く補間され
ません。さらに、Temporal Interpolatorは、トポロジが一貫している場合にのみ動作
することにも注意して下さい。もし、メッシュが時刻ステップによって変化する適
応メッシュの場合は、Temporal Interpolatorはエラーとなります。

2.10 テキストによる注釈
ParaViewをコミュニケーションのための道具として用いるとき、作成した画像に
テキストの注釈をつけることは時に役に立ちます。ParaViewでは、3Dビューにい
つでも好きな時に注釈をつけることが、とても簡単にできます。ビュー内に単にテ
キストを配置する特別なテキスト・ソースがあります。
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演習 2.21: テキストによる注釈の追加
この演習を演習 2.20の続きとして行っているのであれば、そのまま続けて頂いて構
いません。もし、ParaViewを再起動したり、ParaViewの状態が演習を続けるに相
応しくなければ、新たな状態から始めて頂いても構いません。

1. メニューバーから、Sources → Textを選択します。

2. プロパティ・パネルのテキスト入力欄に、適当な文を入力します。

3. ボタンをクリックします。

入力したテキストは、3Dビュー内に現れます。マウスでドラッグするだけで、好
きなところにこのテキストを配置できます。プロパティ・パネルのDisplayグループ
では、テキストのサイズ、フォント、色の追加設定ができます。また、テキストを
最もよく使う位置に配置するためのボタンもあります。

♦

アニメーション上の現在の時刻の値を、テキスト注釈として表示したいことが、
しばしばあります。標準のテキスト・ソースで現在の時間の値を入力するのは退屈
で、間違いを起こしやすく、さらにアニメーションを作る時は、これが不可能です。
そこで、現在のアニメーションの時刻を文字列に挿入する特別なアノーテート・タ
イム・ソースがあります。
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演習 2.22: アノーテート・タイムを追加する

1. 前の演習から読み込んでいなければ、can.ex2ファイルを開き、 をク
リックします。

2. Animate Time ソースを追加し (Sources → Annotate Time か、Win-

dows/Linuxでは Ctrl+Space、Macでは Alt+Spaceのクイック起動を使用し
ます)、 をクリックします。

3. 必要ならば、注釈の位置を適宜移動します。

4. 再生 し、時刻の注釈がどう変化するか観察します。

現在のアニメーションの時刻が、データ・ファイルから読み込まれた時刻ステッ
プと同じでない場合があります。時には、データ・ファイルに保存されている時刻
がいつであるかを知ることが重要なことがありますが、そのような場合には、フィ
ルタとして機能するアノーテート・タイムの特別版を使用することができます。

5. パイプライン・ブラウザで can.ex2を選択します。

6. クイック起動 (Windows/Linuxでは Ctrl+Space、MacではAlt+Space) を使
用し、Annotate Timeフィルタを適用します。

7. をクリックします。

8. 必要ならば、注釈の位置を適宜移動します。

9. Animation Viewで、アニメーション・モードを確認して下さい。もし Snap to

TimeStepsになっていれば、Real Timeに変更して下さい。

10. 再生 をクリックして、時刻の注釈がどう変化するか観察して下さい。



2.11. スクリーンショットとアニメーションの保存 45

♦

アニメーション・ビューは閉じて構いません。これについてはここでいったん終
わりますが、2.13節で再び戻ってくることにしましょう。

2.11 スクリーンショットとアニメーションの保存
どのような可視化であっても、最も重要な成果物の 1つは、発表や報告書に使う

ことのできるスクリーンショットと動画です。この節では、スクリーンショット (画
像)とアニメーション (動画)の保存を行います。再び、can.ex2データ・セットを使
うことにしましょう。

演習 2.23: スクリーンショットの保存
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. can.ex2を開き、全ての変数を読み込む設定とし、 をクリックします
(演習 2.17を参照)。

2. ボタンをクリックして、カメラをメッシュに向けて下さい。

3. GlobalNodeIdで色を付けます。GlobalNodeIdを使うのは、3Dオブジェクトに
何らかの色を付けるためです。

4. File → Save Screenshot を選択します。
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Save Screenshotウィンドウは、多くの重要なコントロールを含んでいます。
このウィンドウの左上には、Save only selected viewチェックボックスがあります。
複数のビューを開いている場合には、このチェックボックスをクリックすると、選
択されているものだけが画像ファイルに書き込まれます。チェックを外すと、全て
のビューが画像ファイルに書き込まれます。
Select resolution for the image to save欄を使うと、現在の 3Dビューのサイズより
も大きな (あるいは小さな)画像を作成することができます。Override Color Palette

プルダウンメニューを使うと、デフォルトの配色、または印刷用の白を基調とした
配色を選んで使うことができます。最後に、Stereo Mode (if applicable)を使うとス
テレオ表示のスクリーンショットを作成することができます。

5. OKボタンを押します。

次にファイル選択画面が表示されます。ダイアログ・ボックスの下部にある、Files

of type:メニューを開くとポータブル・ネットワーク・グラフィックス (PNG)、ジョ
イント・フォトグラフィック・エキスパーツ・グループ (JPEG)を含む、いくつかの
サポートされているファイル形式が確認できます。
File nameを選んでファイル名を指定し、後で探して削除できる場所に保存しま
す。通常は、PNGファイルとして保存することをおすすめします。JPEGの非可逆
圧縮は、ParaViewによって生成される画像に目立って不自然な影響を与えることが
よくありますし、PNGの圧縮はほとんどの他のラスター形式よりも性能が良いから
です。

6. OKボタンを押します。

あなたの好みの画像ビューアを使って、作成した画像を見つけて読み込みます。も
し画像ビューアが無ければ、ParaView自体でPNGファイルを読込むこともできま
す。 ♦
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(例えば、先の演習でOverride Color Paletteによって選択した様な)カラー・パレッ
トとして使用される色は、ParaViewの設定の一部です。これらの色は全て、Color

Paletteタブにある Edit → Settings(Macの場合は ParaView → Preferences)で確認し
たり、設定することができます。

スクリーンショット保存機能は、画像をラスター・グラフィックスとして保存しま
す。つまり、画像は、それぞれが色を持つピクセルから成る長方形の格子によって
表されるということです。これは描画された画像として自然ですし、巨大なデータ・
セットから作成された画像を効率よく扱うことができます。しかしながら、テキス
トやその他のラベルといった要素は歪むことが多く、サイズ変更を行った時には特
にそれが顕著になります。これらの要素は、ベクター・グラフィックスの方がより良
く表現できます。ベクター・グラフィックスでは、幾何的なプリミティブを使用して
形状を描画します。この幾何形状によって、画像が変形された後でも要素はなめら
かなままで、紙への印刷で使用する時にも見栄えが大幅に良くなる傾向があります。
ベクター・グラフィックスを使った画像は、シーンのエクスポート機能を使って

作成できます。この機能はスクリーンショット保存機能とよく似ていますが、別の
ものです。

演習 2.24: シーンのエクスポート

1. 前の演習から読み込んでいなければ、can.ex2を開き、全ての変数を読み込む
設定とし、 をクリックします (演習 2.17を参照)。



48 第 2 章 基本的な使用法

2. ボタンをクリックして、カメラをメッシュに向けて下さい。

3. GlobalNodeIdで色を付けます。GlobalNodeIdを使うのは、3Dオブジェクトに
何らかの色を付けるためです。

4. 缶の周りに Cube Axesを表示します (このチェックボックスはプロパティ・パ
ネルのディスプレイ・オプションの下にあります。検索ボックスに axes と入
力すると、素早く探すことができます)。これによって、シーンにいくつかの
ベクター・グラフィックスが追加されます。

5. File → Export Sceneを選択します。

次にファイル選択画面が表示されます。ダイアログ・ボックスの下部にある、Files

of type:メニューを開くと、ポータブル・ドキュメント・フォーマット (PDF)、ポス
トスクリプト (PS)、エンカプセルド・ポストスクリプト (EPS)、そしてスケーラブ
ル・ベクター・グラフィックス (SVG) を含む、いくつかのサポートされているファ
イル形式が確認できます。

6. (他の形式の手近な表示ソフトウエアを持っていない限り)ファイル形式とし
てPDFを選択し、ファイル名を File nameに入力します。その後でOKを押し
ます。

最後に、選択された形式における、データの保存方法に関するオプションを設定
するためのダイアログ・ボックスが表示されます。通常は、デフォルトの値で問題
ありません。3D形状をラスター化するオプションを無効に (すなわち、画像内の全
てをベクター化)したいと思うかもしれませんが、このオプションを使用することは
通常、お勧めしません。3D形状のベクター・グラフィックスは互換性の無い要素を
含む傾向がありますし、巨大な形状では多くの問題を引き起こす可能性があります。

7. Saveボタンを押します。

適当なPDFビューアを使って、保存したファイルを開いて下さい。Cube Axesの
ラベルと色の凡例を拡大して見て下さい。どれだけ拡大しても、線とテキストが鮮
明で読みやすいことに注意して下さい。 ♦

シーンのエクスポート機能は 2.7節で説明したようなグラフを保存する場合に特
に便利です。
次に、アニメーションを保存してみましょう。
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演習 2.25: アニメーションの保存

1. 前の演習から読み込んでいなければ、can.ex2を開き、全ての変数を読み込む
設定とし、 をクリックします (演習 2.17を参照)。

2. File → Save Animation を選択します。

Animation Settingsダイアログには、重要なコントロールが多数あります。
Resolution (pixels)欄を使うと、現在の 3Dビューのサイズよりも大きな (あるいは

小さな)アニメーションを作成することができます。
Stereo Mode (if applicable)メニューを使うと、ステレオ動画を作成することがで

きます。

3. Save Animationボタンを押します。

次に、ファイル選択画面が表示されます。ダイアログ・ボックスの下部にある、
Files of type:メニューを開くと、Ogg/Theora、AVI、JPEG、そして PNGを含む、
いくつかのサポートされているファイル形式が確認できます。
File nameを選んでファイル名を指定し、後で探して削除できる場所に保存します。

AVI形式を選ぶと、Windowsやいくつかのオープンソースなビューアで使うことの
できる動画形式のファイルを作成できます。Ogg/Theoraは、多くのオープンソース
なビューアで使用されています。それ以外だとパラパラ漫画、つまり連続した画像
を作成することもできます 5。多くのオープンソースなツールを使えば、これらの
画像をつなぎ合わせて、動画を作ることもできます。ここではAVIを作成してみま
しょう。

4. OKボタンを押します。

適当な動画ビューアを使って、作成した動画を探して読込んで下さい。 ♦

5訳注: JPEGおよび PNG形式では、入力されたファイル名に連番を付したファイル名で、各時
刻ステップの画像が保存されます。
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2.12 選択機能
可視化の最終目的はしばしば、大きな情報の実体から重要な細部を見出すことに
あります。ParaViewにおける選択の抽象化は、その過程の重要な簡略化です。選択
とは、何らかのデータ・セットの一部を同定する行為と言うことができます。この
選択を作成するには様々な方法があり、そのほとんどはユーザにとって直感的なも
のです。また、選択がひとたび作成されれば、その選択されたデータに対して特定
の量を表示したり処理する様々な方法があります。
具体的には、1つのデータ・セットの中の部分領域によって、特定の選択された
点、セル、ブロックが同定されます。選択の中にどの要素を含めるかを指定する方
法は複数あり、様々な方法によって作成される ID番号のリスト、空間中の位置、ス
カラー値、スカラー値の範囲などがあります。
ParaViewでは、選択はいつでも行うことができ、現在の選択された領域が全ての
ビューで連動して保持されています。すなわち、いずれかのビューで何かを選択す
れば、その選択範囲は同じオブジェクトを表示する他の全てのビューにも表示され
ます。
選択を作成する最も直接的な方法は、Find Data ダイアログを用いるもので
す。ツールバーまたは Editメニューから、このダイアログを開きます。このダイア
ログに、探索したいデータの特徴を入力します。例えば、終端速度に近い速さを有
する点を探すことができます。あるいは、材料の破壊限界を上回るひずみを有する
セルを探すことができます。以下の演習では、Find Data ダイアログの簡単な使
用例を示します。

演習 2.26: 問合せによる選択を行う
この演習では、等価塑性ひずみ (EQPS) の値が大きなセルを探索します。
新しい可視化を始めることにしましょう。ここまでの演習を行っていた場合はPara-

Viewをリセットする良い機会です。そのためには、メニューのEdit → Reset Session

を選択するのが最も簡単です。

1. can.ex2ファイルを開き、全ての変数を読込む設定とし、 をクリック
してください (演習 2.17を参照)。

2. 最後の時刻ステップに移動します 。

3. データ探索ダイアログ を開きます。

4. 最上部のコンボ・ボックスから、Cellの探索を選択します。

5. 次の行のウイジェットでは、最初のコンボ・ボックスから EQPSを、2つ目の
コンボ・ボックスでは is >=を選択し、最後のテキスト・ボックスに 1.5を入
力します。
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6. Run Selection Queryボタンをクリックします。

Run Selection Queryボタンの下のスプレッドシートが、以上の問合せの結果で埋
められていくのを確かめてください。それぞれの行はセルを表し、それぞれの列は
フィールド値か (ID番号のような) 属性を表します。
さらに、ParaViewのウインドウ中の 3Dビュー中で、幾つかのセルがハイライト

されているのにお気付きかもしれません。これらのハイライトは、以上の問合せに
よって作成された選択を表します。ここで Find Dataダイアログを閉じ、選択がそ
のまま残されていることを確かめてください。 ♦

選択部分を生成するもう 1つの方法は、要素をまさに 3Dビューの中から選び出す
ことです。3Dビューにおけるほとんどの選択操作は、ラバー・バンド選択という機
能によって行います。つまり、3Dビュー内でマウスをクリックしたりドラッグする
ことで、箱状の範囲内の要素を選択することができます。また画面上に描画された
多角形領域内を選択するための 3Dビュー選択機能が他にもいくつかあります。実行
できる選択操作にはいくつかの種類があり、3Dビューの上の小さなツールバーにあ
るアイコンのいずれかを選ぶか、ショートカット・キーのいずれかによってそのう
ちの一つを開始することができます。次の 3Dビューにおける選択方法が可能です。

Select Cells On (Surface) (表面上のセルを選択する) ビュー内において表
面に見えるセルのうち、ラバー・バンドに囲まれたものを選択します。(ショー
トカットは s)

Selects Points On (Surface) (表面上の点を選択する) ビュー内において表
面に見える点のうち、ラバー・バンドに囲まれたものを選択します。

Select Cells Through (Frustum) (表面および内部のセルを貫通的に、錐台
状に選択する) ラバー・バンド内に存在する全てのセルを、視点から奥行方向
に、対象オブジェクト内部のセルも含め貫通的に、錐台状に選択します。

Select Points Through (Frustum) (表面および内部の点を貫通的に、錐台
状に選択する)ラバー・バンド内に存在する全ての点を、視点から奥行方向に、
対象オブジェクト内部の点も含め貫通的に、錐台状に選択します。
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Select Cells With Polygon (多角形でセルを選択する) ラバー・バンド選択
の代わりに、マウス・ドラッグによって多角形を描く、ということ以外はSelect

Cells Onと同じです。

Select Points With Polygon (多角形で点を選択する) ラバー・バンド選択
の代わりに、マウス・ドラッグによって多角形を描く、ということ以外はSelect

Points Onと同じです。

Select Blocks (ブロックを選択する) マルチブロック・データセットから、ブ
ロックを選択します。(ショートカットは b)

sと bのショートカットによって、それぞれセルやブロックを手早く選択できま
す。マウスカーソルを選択中の 3Dビュー上のどこかに置いてから、それらのキー
を入力しましょう。そして、選択したいセルやブロックをクリックしましょう (ある
いは複数の要素上にラバー・バンドをドラッグしましょう)。
ここで、選択機能を様々に試してみて下さい。
選択状態は、Find Data ダイアログで管理できます。選択状態がデータ検索
問合せによる直接的な方法ではなく、3Dビュー操作のいずれかを使って作成され
たものであっても、これは変わりません。Find Dataダイアログでは、選択されて
いる全ての点やセルを表示したり、選択要素に対する簡単な操作を行うことができ
ます。これら操作には、選択状態の反転 (スプレッドシートのすぐ上のチェックボッ
クス)、ラベルの追加 (演習 2.28)、選択状態の固定 (演習 2.27)、Plot Selection Over

Time フィルターや Extract Selection フィルター (それぞれ演習 2.29と演習
2.30)のショートカットが含まれます。
Find Data での選択を少し試してみましょう。Find Data ダイアログ・ボッ
クスを開いてください。そして、ラバー・バンド選択を使って要素を選択し、Find

Dataダイアログ・ボックスに表示される結果を確認してください。また試しに Invert

selectionチェックボックスによって選択状態を反転して、選択範囲を変更してみてく
ださい。
ここで、選択状態は、内部的には様々な方法で表現され得る事を記しておくべき
でしょう。データ要素 IDのリストとして記録されることもありますし、空間的な領
域や問合せのパラメーターによって指定されることもあります。選択状態の見かけ
が同じ場合でも、特に時刻の変化に対しては異なる振る舞いをすることがあります。
以降の演習では、これらの異なる選択方法がどのように異なった振る舞いをするか
を見ていきます。

演習 2.27: データ要素を特定する選択と空間的な選択

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.17を参照)。
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2. Select Cells Through ツールを使って、選択領域を生成してください。

3. もしまだ表示させていなければ、Find Data ダイアログボックス・ボック
スを表示させて下さい。

4. Find Dataダイアログの Show Frustum チェックボックスをクリックし、3D

ビューを回転させます (Show Frustum ボタンは、Select Cells Throughボタン
と同じアイコンです)。

5. アニメーションを少しだけ再生 しましょう。このとき、選択領域は固定さ
れたまま、どのセルが領域内あるいは領域外へ移動するかによって、選択要素
が変化していることに注意して下さい。

6. 適当なデータが選択されている時刻ステップに移動して下さい。Find Dataダ
イアログ。ボックスで Freeze Selectionボタンをクリックします。

7. もう一度再生 してください。今度は、選択されたセルが位置にかかわら
ず変化しないことに注意して下さい。

まとめると、(表面および内部のセルまたは点を選択するツールによって作成され
る) 空間的な選択では、要素が選択領域の内外へ移動するのに対し、それぞれの時
刻ステップごとに選択を実行します。同様に、フィールド値の範囲による問合せも
また、データが変化するたびに再度実行されます。それに対し Freeze Selectionボタ
ンを選択すると、ParaViewは現在選択されている要素の識別子を保存するので、ア
ニメーションの最初から最後まで、選択された要素は維持されます。 ♦

Find Dataダイアログのスプレッドシートによって、フィールド・データを読み
やすい形で表示することができます。しかしながら、3Dビューに直接フィールド・
データを表示するのが便利であることもあります。次の演習では、そのための方法
を解説します。
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演習 2.28: 選択にラベルを付ける

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.17を参照)。

2. 最終時刻ステップ に移動します。

3. まだ表示させていなければ、Find Data ダイアログ・ボックスを表示させ
ます。

4. Find Dataダイアログ・ボックスの上部にあるコントロールを使って、Global

IDが is minの要素を選択します。Run Selection Queryをクリックします。

5. Cell Labels選択で、EQPSを選択します。

この操作によって、EQPSフィールドの値が、その値を有する選択されたセルの
近くに表示されます。3Dビューで、それを確認できるはずです。ラベル選択の右側
にある ボタンをクリックすることで、フォントの種類、大きさ、色を変更するこ
とも可能です。
Cell Labels選択のチェックを外すと、ラベルの表示を消すことができます。 ♦

ParaViewでは、フィールド・データを時間に沿ってプロットできます。全部のデー
タを全ての時刻ステップでプロットしたいことは滅多にないでしょうから、これら
のプロットは選択部分に対して行われるようになっています。

演習 2.29: 時間に沿ってプロットする

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.17を参照)。

2. まだ表示させていなければ、Find Data ダイアログ・ボックスを表示させ
ます。
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3. Find Dataダイアログ・ボックスの上部にあるコントロールを使って、EQPS

が is maxの要素を選択します。Run Selection Queryをクリックします。

4. Find Dataダイアログ・ボックスの下部にある Plot Selection Over Time ボタ
ンをクリックして、フィルタを追加します。このフィルタには、ParaViewの
メインウィンドウにある ツールバーのボタンを使うことでも、簡単にア
クセスできます。

5. ParaViewのメインウィンドウ内のプロパティ・パネルで、 をクリッ
クします。

すると、ParaViewは、EQPSが最大となるセルのフィールド値の時刻に対するプ
ロットを作成します。現時点では、プロットは乱雑なものになっています。これは、
ParaViewが選択要素の全てのフィールド値の統計情報 (例えば、最大のEQPSとな
るセルの要素 ID)を表示しているためです。しかし今、欲しいのはEQPSフィール
ドについての情報だけです。

6. プロパティ・パネルのDisplayコントロールで、max(EQPS)を除く全ての時系
列のプロットをオフにします。

Plot Selection Over Time フィルタが作成された時の選択が、Propertiesパネ
ルにおいてプロットすべき選択として自動的に追加されていることに注意して下さ
い 6。選択を変更するには、新たな選択を行って、Propertiesパネルの Copy Active

Selectionをクリックします。
プロットが、各時刻ステップでの最大 EQPS値であることにも注意して下さい。

これらは、全ての時刻ステップで異なるセルである可能性もあるでしょう。特定の
時刻ステップで最大値を持つセルを特定して、そのセルの値を全ての時刻ステップ
でプロットしたい場合には、演習 2.27で説明した Freeze Selection機能を使用して下
さい。 ♦

6訳注: Copied Selection欄に表示されている EQPS == max(EQPS)等のことです。
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また、選択された点やセルを個別に見たり、それらについてのみ何らかの処理を
行うために、選択部分を抽出することもできます。これは Extract Selection フィ
ルタによって行われます。

演習 2.30: 選択の抽出
新しい可視化を始めることにしましょう。ここまでの演習を行っていた場合はPara-

Viewをリセットする良い機会です。そのためには、メニューのEdit → Reset Session

を選択するのが最も簡単です。

1. can.ex2を開いて、全ての変数を読み込み、 をクリックします (演習
2.17を参照)。

2. 内部も含めたセルの選択 (Select Cells Through) で、多めのセルを選択し
ます。

3. Extract Selection フィルタを適用します (ツールバーから利用可能)。

4. をクリックします。

ビュー内のオブジェクトは、選択したセルに置き換えられます (上の画像では、抽
出したセルを全体のデータと関連させて見せるために、半透明な表面と、もとの選
択部分を示すもう一つのビューを加えています)。 フィルタを選択部分を抽出した
パイプライン・オブジェクトに単に付加するだけで、抽出されたセルに対して演算
を行うことができます。 ♦

2.13 アニメーション
私たちは既に、時間を含むデータ・セットをアニメーションさせる方法 ( を押し
ます)や、複数の時刻ステップを含むデータを操作する方法について、2.9節で見てき
ました。しかし、ParaViewのアニメーション能力はそれ以上のものです。ParaView

では、全てのパイプライン・オブジェクトのほぼ全てのプロパティを、アニメーショ
ンさせることができます。
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演習 2.31: プロパティをアニメーションさせる
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. スフィア・ソースを作成 (Sources → Sphere)し、 をクリックします。

2. まだそうしていない場合には、アニメーション・ビュー・パネルを表示して下
さい:View → Animation View。

3. No. Framesの設定を 50に変更します (10ではアニメーションが速すぎるで
しょう)。

4. アニメーション・ビュー下部のプロパティ選択ウィジェットで、1つ目のボッ
クスで Sphere1を、2つ目のボックスで Start Thetaを選択します。

ボタンをクリックします。

このアニメーションを再生 させると、球が展開して、ついには開ききって消
滅するのが見られるでしょう。

♦

ここで行ったことは、Sphere1オブジェクトの Start Thetaプロパティのためのト
ラックを作成することです。トラックは、アニメーション・ビュー内の水平のバーで
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表されます。そのバーには、ある特定の時刻における、そのプロパティの値を指定
するためのキー・フレームが保持されています。そのプロパティの値は、キー・フ
レームの間で補間されます。トラックを作成すると、開始時刻における最小値と終
了時刻における最大値を保持するそれぞれのキー・フレームが自動的に作成されま
す。ここで設定したプロパティによって、球の開始角度の範囲が決まります。
トラックはその上でダブルクリックすることで、修正できます。ダブルクリック
するとダイアログ・ボックスが表示され、キー・フレームを追加、削除および修正
することができます。

次の演習ではこの機能を、アニメーションに新たなキー・フレームを追加するた
めに使います。

演習 2.32: アニメーション・トラックのキー・フレームを変更する
この演習は、演習 2.31の続きです。この演習を始める前に、演習 2.31を完了させて
下さい。

1. Sphere1 – Start Thetaトラックをダブルクリックします。

2. Animation Keyframesダイアログ内の、Newボタンをクリックします。これで
新たなキー・フレームが作成されます。

3. 1番目のキー・フレームの値を 360に変更します。

4. 2番目のキー・フレームの時刻を 0.5に変更し、値を 0に変更します。

5. OKをクリックします。
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アニメーションを再生すると、球ははじめ大きくなり、その後また小さくなりま
す。 ♦

アニメーションさせられるのは、1つのプロパティだけではありません。必要な
だけの数のプロパティを、アニメーションさせることができます。ここでは、2つの
プロパティを変更するようなアニメーションを作成してみましょう。

演習 2.33: 複数のアニメーション・トラック
この演習は、演習 2.31と演習 2.32の続きです。この演習を始める前に、これらの演
習を完了させて下さい。

1. Sphere1 – Start Thetaトラックをダブルクリックします。

2. Animation Keyframesダイアログで、(時刻ステップ 0の) 最初のキー・フレー
ムを、Deleteボタンをクリックして削除します。

3. OKをクリックします。

4. アニメーション・ビューで、Sphere1オブジェクトの End Thetaプロパティの
ためのトラックを作成します。

5. Sphere1 – End Thetaトラックをダブルクリックします。

6. 2番目のキー・フレームの時刻を 0.5に変更します。

このアニメーションでは、球が生成・消滅するのが見られますが、今回は球形状
の描画範囲の変化部分が同じ方向に回転しています。それによって、このアニメー
ションをループ させたときに、とても満足できるアニメーションとなっていま
す。 ♦

パイプライン・オブジェクトのプロパティをアニメーションさせるのに加えて、
カメラをアニメーションさせることもできます。ParaViewには、指定された曲線
に沿ってカメラを動かす機能があります。最も一般的なアニメーションは、カメラ
をオブジェクトの周りで、常にオブジェクトの方向を向けながら回転させるもので
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しょう。ParaViewには、そのようなアニメーションを自動的に生成する方法があり
ます。

演習 2.34: カメラを周回させるアニメーション
この演習では、何らかの読み込まれたデータに対してカメラを周回させます。もし
以前の演習からの続きでこの演習を行うのであれば、そのまま続けることができま
す。そうでなければ、何らかのデータを読み込むか作成して下さい。効果を確認す
るには、読み込むデータが非対称な形状であることが最適です。can.ex2は、この演
習のために読み込むデータセットとして良いデータでしょう。

1. カメラを周回を始めたい点に設定します。なお、このあとカメラは、視点の右
側に移動して行きます。

2. アニメーション・ビュー・パネルが表示されていることを確認して下さい (表
示されていなければ、View → Animation Viewを選択して下さい)。

3. プロパティ選択のウイジェットで、最初のコンボ・ボックスではCameraを、2

番目のコンボ・ボックスではOrbitを選択します。

ボタンをクリックします。

新たなトラックが作成される前に、周回軌道の設定ダイアログ・ボックスが表示
されます。デフォルトの値は現在のカメラ位置から決定され、通常これらの値のま
まで構いません。

4. OKをクリックして下さい。

5. 再生 をクリックして下さい。

これで、カメラがオブジェクトの周りを周回します。 ♦

もう 1つの一般的なカメラの記述は、オブジェクトが空間内を動くのに合わせて、
それを追跡するというものです。移動する弾丸、あるいは乗り物のシミュレーショ
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ンを想像して下さい。カメラを固定していれば、オブジェクトはすぐに視界の外へ
行ってしまうでしょう。こうした状況を避けるために、ParaViewにはカメラがシー
ン内でデータを追跡できる特別なトラックがあります。

演習 2.35: アニメーションでのデータの追跡
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、メニューの Edit → Reset Sessionを選択す
るのが最も簡単です。

1. can.ex2を開き、全ての変数を読み込む設定とし、 をクリックします
(演習 2.17を参照)。

2. ボタンをクリックして、カメラをメッシュに向けて下さい。

3. アニメーション・ビュー・パネルが表示されていることを確認してください (も
しされていない場合は View → Animation View)。

4. プロパティ選択ウィジェットで、1つ目のボックスに Camera、2つ目のボック
スに Follow Dataを選択します。

ボタンを押します。

5. 再生 をクリックします。

アニメーションでは、缶が潰されてビューの下部に追いやられる代わりに、缶が
持ち上げられて画像の中央に配置されたままとなることに注意して下さい。これは
缶が潰されて下がるのを、カメラが追跡しているためです。 ♦





63

第3章 大規模モデルの可視化

サンディア国立研究所を始めとした機関では、ここに示すものを含む世界最大級
のスーパーコンピュータで実行された大規模シミュレーションのデータを可視化す
るために、ParaViewを頻繁に使用しています。

10億を超えるセルで計算された、ゴレブカ
小惑星の中心で 10メガトン級の爆発が起き
た場合の CTH衝撃物理シミュレーション。

10億セルで計算された、高緯度帯の寒帯気団を
捕らえる周極ジェット気流、すなわち極渦の崩
壊をモデリングした SEAM 気候モデルシミュ
レーション。

AMRデータを出力するCTHシミュレーション。
数十億のセル、数十万のブロック、そして (ここ
には示されていないが)11レベルの階層から構
成された CTHシミュレーションの AMRデー
タの可視化に ParaViewを用いています。

人工ジェットが不安定なクロスフロー・ジェッ
トを引き起こすような全体翼周りの流れを
含む、33億の 4面体セルによる PHASTA
シミュレーション。

本節では、ParaViewの並列可視化機能を用いて、このような大規模メッシュを可
視化する方法を解説します。本節は前節ほど “実践的”ではありません。その代わり、
大規模な並列可視化を行うための概念的な知識を学んで頂くことになります。ここ
では基本的な ParaViewの構造および並列アルゴリズムを示し、これらの知識をど
のように利用するかを実演します。
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3.1 ParaViewの構造
ParaViewは、3層のクライアント・サーバ構造になっています。ParaViewにお
けるそれら 3つの論理的なユニットは、以下のとおりです。

データ・サーバ データの読込み、フィルタリング、書出しを担当するユニットです。
パイプライン・ブラウザに表示される全てのパイプライン・オブジェクトは、
データ・サーバが保持しています。データ・サーバは並列実行が可能です。

レンダー・サーバ レンダリングを担当するユニットです。レンダー・サーバも並列
実行が可能で、その場合は内蔵の並列レンダリング機能が有効化されます。

クライアント 可視化の作成を担当するユニットです。クライアントはサーバにおけ
るオブジェクトの作成、実行、削除を制御しますが、実際のデータは全く保持
しません (そのため、クライアントがボトルネックとなることが無く、サーバ
が大規模データへとスケーリングすることができます)。GUIもまた、クライ
アントに含まれます。クライアントは常にシリアルに実行される、非並列化ア
プリケーションです。

これらの論理ユニットは、物理的に分割されている必要はありません。論理ユニッ
トは多くの場合、同一のアプリケーションに含まれ、それらのユニット間での通信
を不要としています。ParaViewは、以下の 3つのモードで実行されます。

Client 

Data 
Server 

Render 
Server 

最初のモードはスタンドアローン・モードで、既に使用してきたとおりのモード
です。スタンドアローン・モードでは、クライアント、データ・サーバ、レンダー・
サーバは全て一つのシリアル実行アプリケーションに統合されています。paraview

アプリケーションを実行すると、ParaViewの全ての機能をすぐに使えるよう、ビル
トイン・サーバに自動的に接続されます。

Client Data 
Server 

Render 
Server 
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2つ目のモードはクライアント－サーバ・モードです。クライアント－サーバ・
モードでは、pvserverプログラムを並列マシン上で実行し、それに paraviewクラ
イアント・アプリケーションを接続します。pvserverプログラムはデータ・サーバ
とレンダー・サーバの両方を含んでおり、したがってデータ処理とレンダリングの
両方が pvserverで実行されます。クライアントとサーバはソケットを通じて接続
します。ソケット通信は比較的低速な通信手法であるため、このソケットを通じた
データ転送量は最小に抑えられています。

Client Data 
Server 

Render 
Server 

3つ目のモードは、クライアント－レンダー・サーバ－データ・サーバ・モードで
す。このモードでは、全ての 3つの論理ユニットが個別のプログラムとして実行さ
れます。クライアント－サーバ・モードと同様、クライアントはレンダー・サーバ
に 1つのソケットによって接続されます。レンダー・サーバとデータ・サーバはレ
ンダー・サーバのプロセスそれぞれにつき 1つづつ、多数のソケットによって接続
されます。ソケットを通じたデータ転送量は最小に抑えられています。
クライアント－レンダー・サーバ－データ・サーバ・モードはサポートされてはい

ますが、このモードはまず推奨されません。このモードの元々の意図は、大規模で
パワフルな計算プラットフォームと、小規模なグラフィックス・ハードウエアが内蔵
された並列マシンからなる異種混在環境を活用することでした。しかしながら実際
には、データ・サーバからレンダー・サーバへの形状データの転送所要時間によっ
て、あらゆる利点が相殺されてしまうことが判りました。もし計算プラットフォー
ムのほうがグラフィックス・クラスタより非常に大きい場合は、ソフトウエア・レ
ンダリングを使用して下さい。もし両プラットフォームが概ね同じ規模である場合
は、グラフィックス・クラスタで全ての処理を実行して下さい。

3.2 ParaViewサーバのセットアップ
スタンドアローンのParaViewをセットアップするのは通常、難しくありません。

コンパイル済みのバイナリをダウンロードし、コンピュータにインストールすれば、
すぐに実行可能です。しかしながら、ParaViewサーバのセットアップはどうしても、
それよりは難しくなります。まず、サーバを自前でコンパイルしなければなりませ
ん。並列プログラミングのためのライブラリであるMPIには様々な種類のものがあ
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り、さらに個々のMPIは並列コンピュータの通信ハードウエアに合わせて変更が可
能であるため、全ての考えうる組合せについて信頼できるバイナリファイルを提供
するのは不可能です。
ParaViewを並列マシンでコンパイルするには、以下が必要です。

• CMakeクロスプラットフォーム・ビルド・セットアップ・ツール (www.cmake.org)

• MPI

• OpenGL (または、他に利用可能なものが無ければMesa 3D www.mesa3d.org)

• Qt 4.7 (オプション)

• Python +NumPy +Matplotlib (オプション)

オプションのライブラリ無しでコンパイルした場合は、それに対応する機能を利
用できなくなります。Qt無しでコンパイルした場合は、GUIアプリケーションを利
用できません。Python無しでコンパイルした場合は、スクリプト機能を利用できま
せん。
ParaViewをコンパイルするには、まずCMakeを実行し、コンパイルのための設
定とシステム上のライブラリの指定を行います。これによってMakefileが生成され、
そのMakefileを使用してParaViewをビルドします。ParaViewサーバのビルドに関
するさらなる詳細については、ParaView Wikiをご覧下さい。

http://www.paraview.org/Wiki/Setting up a ParaView Server#Compiling

ParaViewを並列に実行するのもまた、必然的にスタンドアローンのクライアント
を実行するより難しくなります。リモート・コンピュータにログインし、並列ノー
ドを確保し、並列プログラムを起動し、接続を確立し、ファイアウオールのトンネ
リングを行うといった、実行環境に依存する幾つもの段階を経る必要があります。
クライアント－サーバ間接続は、paraviewクライアント・アプリケーションに
よって確立されます。サーバに接続し、またサーバへの接続を解除するには、 お
よび ボタンを使用します。ParaViewの起動時には、ビルトイン (内蔵)・サーバ
というサーバに自動的に接続されます。また、サーバへの接続が解除された時にも、
常にビルトイン・サーバに接続されます。

ボタンをクリックすると、接続可能な既知のサーバのリストを含んだダイア
ログが現れます。このサーバのリストはサイト、またはユーザごとに設定できます。

http://www.cmake.org
http://www.mesa3d.org
http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server#Compiling
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どのようにしてサーバに接続するかは、Add ServerボタンをクリックしてGUIで
設定するか、または XMLの設定ファイルによって設定することができます。サー
バ接続を指定するための方法は幾つかありますが、最終的にはサーバを起動するた
めのコマンドと、サーバの起動後に接続するためのホスト名を設定することになり
ます。サーバ接続の確立に関するさらなる詳細については、ParaView Wikiをご覧
下さい。

http://www.paraview.org/Wiki/Setting up a ParaView Server#Running the Server

3.3 並列可視化アルゴリズム
ひとたび並列化のフレームワークさえ手に入れれば、並列可視化を行うのは単純

である点で、私たちは幸運といえます。データはメッシュに含まれていますから、そ
れはすなわち、既にデータがセルによって細かな断片に細分化されていることにな
ります。それらのセルをプロセスごとに分割することで、分散並列マシン上で可視
化を行うことができます。具体的に示すため、以下の非常に簡略化されたメッシュ
を考えます。

このメッシュについて、3つのプロセスを使用して可視化を行いたいとします。以
下に青、黄、ピンク色の領域で示すように、このメッシュのセルを分割します。

ひとたび分割されれば、幾つかの可視化アルゴリズムは、それぞれのプロセスに
おいてローカルに保持されるセルに対してアルゴリズムを独立に実行することで、
処理することができます。クリッピングを例にしましょう (この例は 2.9を含む複数
の演習で例示されています)。クリッピングを行う切断面を定義し、この切断面をそ
れぞれのプロセスに与えます。

http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server#Running_the_Server
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それぞれのプロセスは、この切断面によって独立にクリッピングを行うことがで
きます。最終的に得られる結果は、このクリッピングをシリアルに実行した場合と
同じです。(大規模データでは明らかに、絶対に行うべきではありませんが) これら
のセルをもし、再び結合したとすれば、クリッピング演算が正しく行われたことが
わかります。

3.4 ゴースト・レベル
しかしながら残念なことに、可視化アルゴリズムを分割されたセルに対して闇雲
に実行しても、必ず答えが正しいとはとは限りません。簡単な例として、外部界面ア
ルゴリズムを考えて下さい。外部界面アルゴリズムとは、1つのセルにのみ属するセ
ル界面のすべてを探索する、すなわちメッシュの境界面を特定するアルゴリズムで
す。分割とは無関係に外部界面アルゴリズムを実行した場合、何が起きるでしょう？

おっと。全てのプロセスが外部界面アルゴリズムを個別に実行すると、多くの内
部界面が外部界面として誤って特定されるのが判ります。これは、あるパーティショ
ンのセルが別のパーティションのセルに隣接するところで起こります。プロセスが
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別のパーティションのセルにアクセスする方法がありませんので、これらの隣接セ
ルが存在することを知る方法はありません。
ParaViewや、その他の並列可視化システムで採用されている解決法は、ゴース

ト・セル (ハロー領域と呼ばれることもあります) の利用です。ゴースト・セルとは、
あるプロセスによって保持されていますが、実際には別のプロセスに属するセルの
ことです。ゴースト・セルを使用するには、それぞれのパーティションにおける全
ての隣接セルを特定しなければなりません。そして、それらの隣接セルをそのパー
ティションにコピーし、コピーされたセルをゴースト・セルとして、以下の例では
灰色のセルで示されるようにマークします。

外部界面アルゴリズムをゴースト・セルに対して実行すると、それでもなお幾つ
かの内部界面を外部として誤って特定しているのが判ります。しかしながら、これ
らの全ての誤って特定された界面はゴースト・セルに属しており、したがってそれ
らの界面は属するセルの「ゴーストである」との状態を継承しています。それらの
「ゴーストな」界面は ParaViewによって取り除かれ、正しい解に辿り着きます。
この例では 1層のゴースト・セル、すなわちパーティション内のセルに直接隣接す

るセルのみを示しました。ParaViewでは、複数の層からなるゴースト・セルを取出
すことが可能です。すなわち、それぞれの層が、下のゴースト層あるいは元のデー
タそのものに含まれていない一つ下の層の隣接セルを含んでいます。これは、それ
ぞれがゴースト・セルの層を必要とするようなフィルタを直列に使用する際に便利
です。それらのフィルタは、それぞれ上流側に対して追加のゴースト・セルの層を
要求し、下流側へデータを送る際に 1層だけ取り除きます。

3.5 データの分割
ここではデータを分割して分散させるため、データの分割法の影響に関して議論

しておくこととします。前述の例で示されたデータは空間的にコヒーレントな分割
法と言えます。すなわち、各パーティションのセルは全て空間中のコンパクトな領
域に存在しています。その他にもデータを分割する方法は存在します。例えば、ラ
ンダムに分割する方法も有り得ます。
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ランダム分割には、良い面があります。というのも、パーティションの作成およ
び負荷分散が容易であるからです。しかしながら、ゴースト・セルに関しては、深
刻な問題が存在します。

この例では、1層のゴースト・セルによって、全プロセスにおいてデータセット
のほぼ全体が複製されてしまっていることが判ります。したがって、並列処理の利
点がほぼ失われてしまっています。ParaViewにおいてゴースト・セルは頻繁に使用
されるため、ParaViewではランダム分割は使用されていません。

3.6 D3フィルタ
前節では、並列可視化のための負荷分散およびゴースト・セルの重要性を述べま
した。本節では、負荷分散のための方法を述べます。
負荷分散およびゴースト・セルは、構造データ (画像データ、直線格子、および構
造格子) を読み込んだ際には、ParaViewによって自動的に取扱われます。構造デー
タが暗黙に有するトポロジのために、データを空間的にコヒーレントなパーティショ
ンに分割し、隣接セルの位置を特定するのが容易であるためです。
ところが、非構造格子 (ポリ・データおよび非構造格子) を読み込む際には、全く
異なった状況になります。非構造格子には、暗黙のトポロジや隣接セルの情報があ
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りません。このときの ParaViewの動作は、どのようにデータがディスクに書かれ
たかに依存します。したがって、非構造格子が読み込まれる際には、そのデータが
どの程度良好に負荷分散されるかについては保証されません。さらに、そのような
データがゴースト・セルの情報を含んでいる可能性は低いため、幾つかのフィルタ
の出力は正しくない可能性があります。
幸い ParaViewには、非構造格子の負荷分散を行って、ゴースト・セルを作成す

るためのフィルタがあります。このフィルタは、distributed data decomposition (分
散データ分割) の頭文字をとってD3と呼ばれます。D3フィルタの使用法は簡単で、
(Filters → Alphabetical → D3に存在する) このフィルタを、分割し直したいデータ
に適用するだけです。

D3の最も一般的な使い方は、非構造格子データ読み込みモジュールに対して直接
適用する方法です。読み込まれたデータが如何にうまく負荷分散されていても、以
降のフィルタが正しいデータを生成するよう、ゴースト・セルを抽出することは重
要です。上記の例は、ある非構造格子へ表面抽出フィルタを適用した結果の断面で
す。左図ではゴースト・セルが無いために、多くの界面が誤って抽出されているこ
とが判ります。一方で右図では、D3フィルタをまず最初に適用することで、その不
具合が修正されています。

3.7 ジョブ・サイズにデータ・サイズを合わせる
ParaViewサーバとして、幾つのコアを使用すべきでしょうか。これは多くの重要

な影響を含む、普遍的な質問と言えます。そしてまた、非常に難しい質問でもあり
ます。それぞれのプロセッサにどのようなハードウエアが対応付けられているか、
どの程度の大きさのデータを処理しようとしているか、どのような型のデータを処
理しようとしているか、どのような種類の可視化操作を行おうとしているか、そし
てユーザ自身の我慢強さなどの要因によって、その回答は大きく左右されます。
したがって、確固たる回答はありません。しかしながら、幾つかの経験則はあり

ます。
構造データ (画像データ、直線格子、構造格子) に対しては、少なくとも 2,000万

セルにつき 1つのコアが与えられるようにしてください。もしさらにコアを割り当
てられるなら、500から 1,000万セルにつき 1コアが与えられれば、通常は充分です。
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非構造データ (ポリ・データ、非構造格子) に対しては、少なくとも 100万セルに
対し 1コアが与えられるようにしてください。もしさらにコアを割り当てられるな
ら、25万から 50万セルにつき 1コアが与えられれば、通常は充分です。
前述のように、これらは経験則に過ぎず、絶対的法則ではありません。常にデー
タ量に対してどの程度のコアが適切かを評価し、実験するように努めるべきです。
そしてもちろん、読み込みたいデータの規模が、ユーザが利用可能な計算機資源の
限界を拡大する時が来る可能性は、常にあります。このような状況になれば、デー
タ量の爆発的増大を確実に回避し、データを確実に間引きたくなることでしょう。

3.8 データ量の爆発的増大の回避
ParaViewの有するパイプライン・モデルは、試行錯誤による可視化にはとても便
利です。コンポーネント間の連携が緩やかであるため、型どおりでない可視化の構
築のためのとても柔軟なフレームワークとなっています。また、パイプライン構造
のため、設定を素早く容易に追い込むことができるようになっています。
この連携方法の欠点は、メモリ使用量が比較的多くなることです。パイプライン
の各段階でそれぞれがデータを重複して保持するためです。ParaViewは可能な時
は常に、パイプラインの各段階がメモリ内の同一の領域のデータを参照するよう、
データの浅いコピーを行います。しかしながら、新たなデータを作成したり、デー
タの値やトポロジを変更するようなフィルタは全て、それらの結果のための新たな
メモリを確保せざるを得ません。ParaViewが非常に大きなメッシュに対してフィル
タを適用する場合には、フィルタの使用法が適切でなければ即座に利用可能なメモ
リを全て使い尽くしてしまいます。したがって、大規模なデータセットを可視化す
る際には、フィルタのメモリ所要量を理解しておくことが重要です。
ただし、以下の助言は非常に大規模なデータを取扱っていながら、使用可能なメ
モリが少なくなっている時のためのみであることに注意してください。メモリが尽
きる心配がなければ、以下の助言は全て無視してください。
構造データを扱っているときは、どのフィルタがデータを非構造データに変更す
るかを知っておくことは絶対的に重要です。なぜなら、非構造データは、トポロジを
明示的に記述する必要があるため、構造データよりもセルあたりのメモリ使用量が
大幅に増大するからです。ParaViewには、トポロジを何らかの方法で変更するフィ
ルタが数多く存在し、それらのフィルタは生成されるあらゆる種類のトポロジを扱
えるデータセットが非構造データのみであるため、データを非構造格子として書き
出します。以下にリストされたフィルタは、入力とおおむね等しい新たな非構造格
子トポロジを出力に書き出します。これらのフィルタは、絶対に構造データに対し
ては使用するべきではなく、非構造データに対してのみ注意しながら使用するべき
です。
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• Append Datasets

• Append Geometry

• Clean

• Clean to Grid

• Connectivity

• D3

• Delaunay 2D/3D

• Extract Edges

• Linear Extrusion

• Loop Subdivision

• Reflect

• Rotational Extrusion

• Shrink

• Smooth

• Subdivide

• Tessellate

• Tetrahedralize

• Triangle Strips

• Triangulate

技術的には、Ribbonおよび Tubeフィルタもこのリストに含まれます。しかしな
がら、それらはポリ・データ中の 1次元のセルにのみ作用するため、入力データは
通常小規模で、ほとんど影響はありません。
次の同様な一連のフィルタもまた、非構造格子を出力しますが、一般的にはその

データ量 (格子数) をいくらか削減します。ただし、このデータ量削減は多くの場
合、非構造格子への変換によるオーバーヘッドを補う程ではないことに注意して下
さい。また多くの場合、このデータ量の削減は (負荷分散の点では) あまり上手くバ
ランスしないことに注意して下さい。いずれかのプロセスにおいて、セルが全く削
減されないことも (往々にして) あります。したがって、これらのフィルタは非構造
データに対しては注意深く、また構造データに対しては非常に注意深く使用する必
要があります。

• Clip

• Decimate

• Extract Cells by Region

• Extract Selection

• Quadric Clustering

• Threshold

上のリストの項目と同様に、Extract Subset は構造データセットに対してデー
タ量削減を行いますが、構造データを出力します。したがって、新たなデータが作成
されるという注意点は同様ですが、非構造データに変換されるとの心配は不要です。
以下の一連のフィルタもまた非構造データを出力しますが、(3次元から 2次元へ

のような) データの次元の削減を行いますので、出力はずっと小さくなります。し
たがって、これらのフィルタは通常、非構造データに対しても使用することができ、
構造データに対しても多少の注意を払えば充分です。
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• Cell Centers

• Contour

• Extract CTH Fragments

• Extract CTH Parts

• Extract Surface

• Feature Edges

• Mask Points

• Outline (curvilinear)

• Slice

• Stream Tracer

これらのフィルタはデータのコネクティビティを全く変更しません。そのかわり、
データにフィールド配列のみを付加します。既に存在するデータに対しては浅いコ
ピーが行われます。これらのフィルタは通常、どのようなデータに対しても使用す
ることができます。

• Block Scalars

• Calculator

• Cell Data to Point Data

• Curvature

• Elevation

• Generate Surface Normals

• Gradient

• Level Scalars

• Median

• Mesh Quality

• Octree Depth Limit

• Octree Depth Scalars

• Point Data to Cell Data

• Process Id Scalars

• Python Calculator

• Random Vectors

• Resample with dataset

• Surface Flow

• Surface Vectors

• Texture Map to...

• Transform

• Warp (scalar)

• Warp (vector)

以下の最後の一連のフィルタは、データを出力に全く追加しない (全ての出力デー
タは浅いコピーによって得られる) か、付加されるデータは入力データの量に依存
しないフィルタです。これらはどんな状況でも、まず問題なく使用することができ
ます (ただし、処理時間は要するかもしれません)。

• Annotate Time

• Append Attributes

• Extract Block

• Extract Datasets
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• Extract Level

• Glyph

• Group Datasets

• Histogram

• Integrate Variables

• Normal Glyphs

• Outline

• Outline Corners

• Plot Global Variables Over Time

• Plot Over Line

• Plot Selection Over Time

• Probe Location

• Temporal Shift Scale

• Temporal Snap-to-Time-Steps

• Temporal Statistics

上記の分類には上手くあてはまらない、特殊なフィルタも存在します。それらの
フィルタの幾つか (今のところ Temporal Interpolatorと Particle Tracer) は、データ
が時間によってどのように変化するかに基づいて処理を行います。したがって、こ
れらのフィルタは 2ステップ、またはそれ以上の時刻ステップを読み込む必要があ
り、メモリ上で必要なデータの量が倍、またはそれ以上となる可能性があります。
Temporal Cacheフィルタも、複数の時刻ステップにおけるデータを保持します。ま
た、時間軸方向の処理を行うフィルタの幾つか、例えばTemporal Statisticsや、時間
軸に沿ってデータをプロットするようなフィルタは、全てのデータをディスクから
反復的に読み込む必要があります。したがって、たとえ余分なメモリを使用しなく
ても、非実用的なほど長い処理時間を要する可能性があります。
Programmable Filter もまた、分類が不可能な特殊なケースです。このフィルタ

はプログラミングされたとおりの処理を行いますので、これらの分類のいずれにも
あてはまる可能性があります。

3.9 データを間引く
大規模なデータを扱う際には、可能な限りデータを間引くことが明らかに最良の

策であり、それも早い段階で行うほど、良いといえます。ほとんどの大規模データ
は 3次元の形状として読込まれますが、所要の形状はそのデータの (表面などの) 面
であることがしばしばあります。面データの所要メモリは通常、その元となる立体
データよりも大幅に小さいため、早い段階で面データに変換するのが最良といえま
す。ひとたびそのようにすれば、他のフィルタを比較的安全に適用することができ
ます。
非常に一般的な可視化の操作としては、Contour フィルタを使用して立体デー

タから等値面を抽出することが挙げられます。Contourフィルタは通常、入力より
ずっと小さなデータ量の形状を出力します。したがって、いかなる状況であれ、も
し Contourフィルタを使用するのであれば、早い段階で適用するべきです。とはい



76 第 3 章 大規模モデルの可視化

え、Contourフィルタは大量のデータを生成する可能性もありますので、設定には
注意して下さい。大量の等値面を生成する値を指定すれば、当然ながらそのような
状況は起こり得ます。データ中の等値面を生成する値の上下に、ノイズのような高
周波の変動が存在すれば、それも大量の不整形な面を生成する原因となります。
立体データの内部を見るもう一つの方法は、Slice フィルタを適用することで
す。Slice フィルタは、立体データを面によって薄切りにして、立体内の面が切断
する部分のデータを見えるようにします。もし大規模データの中で興味深い特徴を
有する位置が既に判っていれば、薄切りにするのがそのデータを見る良い方法です。
もしもデータについてあらかじめ与えられた情報がほとんどなく、しかも全デー
タセットに対するメモリ量や処理時間を必要とすることなくデータを調べたいので
あれば、Extract Subset フィルタを使用してデータの一部の領域を抽出、および
間引くことができます。間引かれたデータの量を元のデータよりも大幅に小さくす
ることは可能でありながら、間引かれたデータは良好に負荷分散されているはずで
す。もちろん、間引くことによって細かなデータの変化は失われる可能性があり、必
要なデータの特徴を発見したら完全なデータセットに戻って可視化を行うべきであ
ることは注意して下さい。
立体データの一部を取り出すことのできるフィルタは、幾つかあります。Clip

、Threshold 、Extract Selection、そして Extract Subset はいずれも、何らか
の基準によってセルを抽出することができます。しかしながら、抽出されたセルが
上手く負荷分散されている可能性はほとんど無く、全くセルが取り除かれないプロ
セスも存在する可能性に注意して下さい。また、Extract Subset 以外のこれらの
フィルタは全て、構造データ型を非構造格子に変換します。したがってこれらは、抽
出されたセルが元のデータより少なくとも一桁以上少なくなるのでない限り、使用
するべきではありません。
可能であれば、3次元データを抽出するフィルタを 2次元の面を抽出するフィル
タで置き換えてみて下さい。例えば、データ中のある平面を調べたいのであれば、
Clip フィルタよりも Slice フィルタを使用して下さい。もしある範囲内の値
を含むセルの領域の位置を調べるのであれば、Threshold フィルタを使って全て
のセルを抽出するよりも、Contour フィルタを使ってその範囲の両端となる等値
面を生成するようにしてみてください。ただし、このように代わりのフィルタを使
用すると、下流側のフィルタに影響する可能性があることに注意して下さい。例え
ば、Threshold フィルタの後にHistogram フィルタを実行するのは、ほぼ同
等の Contour フィルタの後に実行するのとは全く異なった結果となります。

3.10 メモリの追跡
非常に大規模なモデルを扱う場合には、コンピュータのメモリ使用量を追跡する
ことが大切です。大規模なモデルで遭遇する最も一般的で、苛立たしい問題の 1つ
は、メモリを使いきってしまうことです。これが起きると仮想メモリ・システムで
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のスラッシングや、即座のプログラム障害が引き起こされます。
3.8節と 3.9節では、メモリ使用量を減らすための方法が紹介されています。しか

しその場合でも、システムで使用できるメモリ量は監視していた方が賢明でしょう。
ParaViewには、まさにそれを行うために設計されたメモリ・インスペクタと呼ばれ
るツールがあります。

メモリ・インスペクタを使用するには、メニューバーのView → Memory Inspector

を選択します。メモリ・インスペクタでは、動作中のクライアントと、接続してい
る全てのサーバの両方の情報を取得できます。メモリ・インスペクタには、システ
ムで使用されているメモリの総量と、ParaViewが使用しているメモリの量が表示
されます。複数のノードがあるサーバでは、ジョブ全体と各ノードごと、両方の情
報が与えられます。1つでもノードにメモリ上の問題が起きた場合には、ParaView

ジョブ全体に障害が起きる可能性があることを意識して、メモリ・インスペクタを
活用して下さい。

3.11 レンダリング
レンダリングとは、データから実際に目にする画像を生成する処理のことです。

データと効率的にインタラクションする能力は、レンダリングのスピードに大きく
依存します。コンピュータ・ゲーム市場に牽引された 3次元処理のハードウエア・ア
クセラレーションの進歩によって、高価でないコンピュータでさえ、3次元画像を
高速にレンダリングできるようになりました。しかしながらもちろん、レンダリン
グの速度はレンダリングされるデータの量に比例します。データが大きくなるほど、
レンダリング処理は必然的に遅くなります。
可視化セッションが確実にインタラクティブに実行されるため、ParaViewは 2つ

のモードをサポートしており、それらのモードは必要に応じて自動的に切り替えら
れます。スティル・レンダーと呼ばれる 1つ目のモードでは、データは可能な限りの
ディテールを保持してレンダリングされます。このレンダリング・モードでは、確
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実にデータの全てが正確に表現されます。インタラクティブ・レンダーと呼ばれる 2

つ目のモードでは、正確さよりも速度が優先されます。このレンダリング・モード
では、データの大きさにかかわらず、高速なレンダリングが行われるよう配慮され
ます。
マウスによる回転、パン、ズームなどの、3Dビューにおけるインタラクションを
行っている間は、ParaViewはインタラクティブ・レンダーを行います。これはイン
タラクションの間、これらの機能を実用的に保つため、高いフレームレートが必要
であるのと、インタラクションの間それぞれのフレームはすぐに次のフレームで置
き換えられるため、このモードにおいては精細なディテールはあまり重要でないた
めです。3Dビューにおけるインタラクションが行われていない時は、ParaViewは
データの全てのディテールが明らかになるよう、スティル・レンダーを使用します。
3Dビューでマウスをドラッグしてデータを動かすと、マウスを動かしている間は概
略のみがレンダリングされますが、マウスボタンを放すとすぐに完全なディテール
まで表現されるのがお判り頂けるでしょう。
インタラクティブ・レンダーは速度と正確さの妥協の産物です。したがって、いつ、
どのように粗いディテールが使用されるかについては、多くの設定が関係します。

3.11.1 基本的なレンダリング設定
最も重要なレンダリング設定の幾つかは、LODに関する設定です。インタラク
ティブなレンダリングの間、形状は低いディテールのレベル (LOD)、すなわちより
少ないポリゴンで表現された近似的な形状に置き換えられることがあります。

形状の近似化の解像度は、変更することができます。上の画像では、左の画像は
完全な解像度です。中央の画像はインタラクティブな操作時のレンダリング用のデ
フォルトの形状簡略化の結果で、右の画像は ParaViewで最大簡略化設定時のもの
です。
3次元レンダリングの設定は、メニューの Edit → Settings (Macでは ParaView →

Preferences) で現れる設定ダイアログボックスにあります。ダイアログを開くと、基
本的なレンダリング設定が Render Viewタブにあります。
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インタラクティブ・レンダリング時の形状簡略化に関する設定は、Interactive Ren-

dering Optionsというラベルのセクションにあります。これらの設定のいくつかは高
度なもので、使用するためには ボタンで高度な設定に切り替えるか、ダイアロ
グの上部にあるエディット・ボックスを使って検索を行う必要があります。インタラ
クティブ・レンダリング設定には以下の様なものがあります。

• インタラクティブ・レンダリングで簡略化された形状を使用するデータのサイ
ズを設定します。形状のサイズがこのしきい値を下回る場合、ParaViewは常
に完全な形状をレンダリングします。大規模なデータを処理できる十分な性能
のグラフィック・カードを使っている場合は、この値を増やして下さい。イン
タラクティブ・レンダーが遅すぎる場合には、この値を減らしてみてください。

• 簡略化された形状がどれだけの大きさになるかを制御する係数を設定します。
この項目は 0から 1までの間の値です。0にすると非常に少ない三角形になり
ますが、歪みは非常に大きくなる可能性があります。1ではより詳細な面にな
りますが、より大きなサイズの形状になります。

• インタラクティブ・レンダーとスティル・レンダーの間に待機時間を加えます。
ParaViewは通常、操作による動きが終了すると (例えば、回転後にマウスの
ボタンを離すと)、直ちにスティル・レンダーを行います。この設定を使うと、
スティル・レンダーが開始される前に次の操作を開始するための時間を取るこ
とができ、スティル・レンダーが完了するまでに長い時間がかかる場合に便利
です。

• 簡略化された形状の代わりに、外形線を描画します。外形線は形状簡略化に長
い時間がかかったり、簡略化しても多くの形状が生成される場合の代替手段で
す。しかし、外形線だけで操作するのは、通常よりも難しくなります。
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ParaViewには、他にも多くのレンダリング設定があります。ここではParaView

がクライアント・サーバ・モードかどうかに依らず、レンダリング性能に影響を与
える可能性のある他の設定について、簡単に紹介します。これらの設定はいくつか
の区分にわたっており、設定のいくつかは高度なものであると言えます。

Geometry Mapper Options (形状マッパー設定)

• ディスプレイ・リスト使用の有無を切り替えます。ディスプレイ・リスト
とは、グラフィックス・システムによって作成される内部構造です。レン
ダリングを高速化できる可能性がありますが、より多くのメモリを消費
する場合があります。

Translucent Rendering Options (半透明レンダリング設定)

• デプス・ピーリングの有無を切り替えます。ParaViewでは、半透明のサー
フェイスを正しくレンダリングするために、デプス・ピーリングと呼ばれ
る手法を使用します。このアルゴリズムでは、まず最前面のサーフェイ
スがレンダリングされ、そして次にその下のサーフェスがレンダリング
されるよう「剥がされる」プロセスが繰り返されます。もしサーフェイ
スを半透明にすることで動作速度が大幅に落ちたり、レンダリング結果
が正しくないようなら、グラフィックス用ハードウエアにおけるデプス・
ピーリング拡張の実装が良くない可能性があります。デプス・ピーリン
グを無効にしてみてください。

• デプス・ピールの数の最大数を設定します。ピールの数を増やすことで、
複雑な深さを正しくレンダリングできるようになりますが、逆に減らす
ことで、レンダリングの速度を上げることができます。半透明な形状の
レンダリングが遅すぎたり、半透明画像が不正確に見える場合には、こ
のパラメータを調整してみてください。

Miscellaneous (その他)

• 非常に大規模なデータセットを作成する場合、デフォルトでは外形線表示
になります。面表示では通常、ParaViewは面形状の抽出を行いますが、
これには時間とメモリが必要になります。このしきい値を超えるサイズ
のデータでは、代わりにデフォルトとして非常に負荷の少ない外形線表
示が使用されます。

• レンダリング・パフォーマンス情報の表示、非表示を切り替えます。こ
の情報は、性能の問題を診断する場合に便利です。

これが、ParaViewのレンダリング設定の完全な一覧ではないことに注意して下さ
い。レンダリング性能に大きな影響を与えない設定については、触れていません。
また、並列のクライアント・サーバ・レンダリングでしか有効でない設定について
も触れていません。これらについては 3.11.4節で説明します。
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3.11.2 基本的な並列レンダリング
並列可視化を行う際には、レンダリングに至るまで、およびレンダリング自体の全

てのプロセスにおいて、データが分割されているよう注意します。ParaViewでは、
IceTと呼ばれる並列レンダリング・ライブラリが使用されます。IceTでは、ソー
ト・ラスト・アルゴリズムが、並列レンダリングに使用されます。この並列レンダ
リング・アルゴリズムでは、それぞれのプロセスはそれぞれに与えられた分割され
た形状を独立にレンダリングし、その結果の部分的な画像を重畳して最終的な画像
を生成します。

上の図は大幅に簡略化したものです。IceTには、2分木法、バイナリ・スワップ
法、基数 k法のような、いくつかの段階を用いて処理を効率的にプロセス間に分割
する、複数の並列化された画像重畳アルゴリズムが含まれています。

ソート・ラスト法による並列レンダリングの素晴らしい点は、その効率がレンダ
リングされるデータの量に全く依存しないことです。そのため、この手法は非常に
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スケーラブルで、大規模なデータに適しています。しかしながら、並列レンダリン
グのオーバーヘッドは画像中の画素数に対して線形に増加します。したがって、レ
ンダリング設定の幾つかは画像の大きさに関するものです。

IceTは、タイリング表示されたディスプレイ (多数の並べられたモニタやプロジェ
クタによって構成される、大型・高解像度のディスプレイ) を駆動する能力があり
ます。ソート・ラスト・アルゴリズムをタイリング・ディスプレイに使用するのは、
重畳すべき画素数が非常に多くなるため、やや直感的ではありません。しかしなが
ら IceTでは、それぞれのプロセスに存在するデータの特定の局所性を利用して、必
要な重畳処理を大幅に低減するようになっています。この空間的な局所性は、デー
タに対しD3フィルタを適用することで強制することができます。
並列レンダリングにはオーバーヘッドが存在するため、ParaViewではいつでも並
列レンダリングをオフにすることができます。並列レンダリングがオフの時は、形
状データが実際に表示が行われる所に転送されます。明らかに、これはレンダリン
グするデータが小さいときにのみ行うべきです。

3.11.3 画像ディテールのレベル
並列レンダリングのアルゴリズムによって発生するオーバーヘッドは、生成され
る画像の大きさに比例します。また、サーバ上で生成された画像はクライアントに
転送する必要があり、そのコストも画像の大きさに比例します。ユーザによるイン
タラクションの間のフレームレート向上を補助するため、ParaViewには画像の大き
さを制御する新たな LODパラメータが導入されています。
並列レンダリングにおけるインタラクションの間、ParaViewでは設定により画像
を間引くことができます。すなわち、ParaViewがインタラクションの間、画像の縦
横各方向解像度をある割合で減らします。間引かれた画像がレンダリングされ、重
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畳され、そしてクライアントへ転送されます。クライアントでは、転送された画像
がGUIの画面サイズに合わせて拡大されます。

間引かれた画像の解像度は、各方向の解像度を割る除数によって制御されます。
上の画像では、左の画像が完全な解像度となっています。それに続いて、それぞれ
2、4、8分の 1に間引かれた解像度でレンダリングされた画像となっています。
また、ParaViewでは、サーバからクライアントへ転送する前に画像を圧縮するこ

ともできます。もちろん、圧縮によって転送されるデータの量は減るので、利用可
能な帯域幅を最大限に活用することができます。ただし、画像を圧縮、展開するた
めの時間が遅延時間に加わります。
ParaViewには、クライアント・サーバ用に異なる 2つの画像圧縮アルゴリズムが

用意されています。1つ目は Sequential Unified Image Run Transfer(順次統合画像
連転送) の略であるSquirtと呼ばれる独自のアルゴリズムです。Squirtは連長圧縮
手法の 1つで、連長を増やすために色深度を減らします。2つ目のアルゴリズムで
は、Lempel-Zivアルゴリズムの一種を実装したZlib 圧縮ライブラリを使用します。
一般的に Zlibでは Squirtよりも圧縮率が高くなりますが、処理により長い時間がか
かり、それによって遅延時間が増加します。

3.11.4 並列レンダリングの設定
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他の 3次元レンダリングの設定と同じように、並列レンダリングの設定も Edit →
Settings (Macでは ParaView → Preferences) によって現れる設定ダイアログボック
スに配置されています。ダイアログの中で、並列レンダリングの設定はRender View

タブにあります (3.11.1節で説明されているようないくつかの他のレンダリング設定
と混在しています)。並列設定とクライアント・サーバ設定はいくつかの区分に分け
られており、設定のいくつかは高度なものであると言えます。

Remote/Parallel Rendering Options(リモート/並列レンダリング設定)

• リモートで並列にレンダリングするか、ローカルでレンダリングするか
を決めるデータサイズを設定します。形状がこのしきい値を超え ( なお
かつParaViewがリモート・サーバと接続してい)ると、データは並列で
リモートにレンダリングされ、画像がクライアントに送り返されてきま
す。形状がこのしきい値を下回ると、形状がクライアントに送り返され、
画像はクライアント上でローカルにレンダリングされます。

• スティル (非インタラクティブ)・レンダリング用のサブサンプリング係
数を設定します。大きなディスプレイのなかには実際に必要とするより
も解像度が高いものがありますが、このサブサンプリングは表示される
全ての画像の解像度を減らします。

Client/Server Rendering Options(クライアント・サーバ・レンダリング設定)

• インタラクティブ・サブサンプリングの係数を設定します。並列レンダ
リングの負荷は生成される画像のサイズに比例します。従って、画像の
サブサンプリング率を指定することでインタラクティブ・レンダリング
を高速化することができます。このボックスがチェックされている場合、
インタラクティブ・レンダリングではより小さな画像が作成され、表示
時にそれが拡大されます。この設定はインタラクティブ・レンダリング
されている間のみ使用されます。

Image Compression(画像圧縮)

• 画像がサーバからクライアントに転送される前に、その画像を 2つのア
ルゴリズムのいずれかによって圧縮することができます。すなわち Squirt

または Zlibです。圧縮をさらに効果的にするために、いずれのアルゴリ
ズムでも圧縮前に画像の色深度を削減することができます。スライダに
よって、削減後に保持される色深度のビット数を指定します。スティル・
レンダーの時は、常にフルカラーの色深度が使用されます。

• いくつかの一般的なネットワークの種類のための推奨の画像圧縮プリセッ
トが提供されています。最も良い画像圧縮設定を選択しようとする場合
には、使用している接続に最も合っているプリセットをまず最初に試し
てください。
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3.11.5 大規模データのための設定
デフォルトのレンダリング設定は、ほとんどのユーザに適しています。しかしな

がら、非常に大規模なデータを扱う時は、設定を追い込むことが有効であることが
あります。最適な設定はデータおよび ParaViewが実行されるハードウエアによっ
て変わりますが、以下のような助言に従うと良いでしょう。

• ディスプレイ・リストをオフにしてみてください。この設定をオフにすると、
グラフィックス・システムがレンダリングのための特殊なデータ構造を作成し
なくなります。グラフィックスのためのハードウエアが装備されている場合は、
これらのレンダリングのためのデータ構造は、GPUにデータを十分高速に供
給するために重要です。しかしながら、GPUが装備されていなければ、これ
らのレンダリングのためのデータ構造は、大して役に立ちません。

• 特定のデータセットで、最初のインタラクティブ・レンダーの前に長い待ち時
間がある場合は、恐らく簡略化された形状を作成するのに時間がかかっていま
す。操作時には、簡略化された形状の代わりに外形線を使ってみてください。
また、簡略化の係数を 0に向けて減らし、より小規模な形状を作成することも
できます。

• クライアントへの大規模な形状の転送を無効化して下さい。リモート・レンダ
リングでは、サーバ全体の能力を使ってレンダリングを行い、画像がクライア
ントへ転送されます。リモート・レンダリングが無効の場合、形状がクライア
ントへ戻されます。大規模なデータの場合、データを転送するより画像を転送
する方が常に高速です (ただし、使用しているネットワークが高遅延の場合、
インタラクティブな操作時のフレームレートが問題になることがあります)。

• 必要に応じて、クライアント・サーバ・レンダリング時のインタラクティブ画
像サブサンプリングを調整して下さい。画像合成に時間がかかったり、クライ
アントとサーバの間の接続が狭帯域であったり、非常に巨大な画像をレンダリ
ングしている場合には、サブサンプリング率を高くすることでインタラクティ
ブ・レンダリングの性能を大幅に改善できます。

• Image Compressionがオンであることを確認して下さい。この設定は、デスク
トップへの画像データ転送性能に大きく影響します。また、この設定によって
引き起こされる画質低下は最小限であり、かつ影響を受けるのはインタラク
ティブ・レンダリング時のみです。狭帯域幅接続の場合には Squirt圧縮の代わ
りに Zlibを使用してみてください。Zlibはより長い圧縮/展開時間と引き換え
に、より小さな画像を作成します。

• ネットワーク接続が高遅延の場合、操作中のリモート・レンダリングを避ける
よう設定を調整して下さい。その場合には、リモート・レンダリングのしきい
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値を少し上げます。また、インタラクティブ・レンダリング時の外形線の使用
が効果的な場面でもあります。

• スティル (非インタラクティブ)・レンダーが遅い場合、不必要なレンダリング
を避けるために、インタラクティブ・レンダリングとスティル・レンダリング
の間の待機時間を設けてみてください。
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ParaViewにおけるPythonによるスクリプティングは、主に 2つの用途に活用す
ることができます。1つはGUIでユーザが行うのと同じことを行って、設定や可視
化の実行を自動化することです。もう 1つは、Pythonスクリプトをパイプライン・
オブジェクトの中で走らせ、それによって並列可視化アルゴリズムを実行すること
です。本章では、最初のモード、すなわち可視化の自動化のためのバッチ的なスク
リプティングを述べます。
バッチ・スクリプティングは日常的な、あるいは繰返し行う処理の自動化に向い

ていますが、同時に、GUIの使用が望ましくない、あるいは使用できない状況で
ParaViewを使用するには必須の手法です。Pythonスクリプトを使用した自動化に
よって、ParaViewをスケーラブルな並列ポストプロセッシングのためのフレームワー
クとして活用することができます。また筆者らは、シミュレーション・コード内で、
シミュレーションと同時に (in situ) 可視化を行うためにも、Pythonによるスクリ
プティングを使用しています (ParaViewは、Catalystと呼ばれる同時実行 (in situ)

ライブラリをサポートしています。このライブラリは、このチュートリアルには記
載されていません。Catalystの詳しい情報については http://catalyst.paraview.org/

を参照して下さい)。
このチュートリアルでは、Python によるスクリプティングの、導入的な解

説のみを行います。スクリプティングに関するより包括的な解説は、ParaView

User’s Guide にあります。また ParaViewのドキュメンテーション・ウェブページ
(http://www.paraview.org/documentation) には、ParaView Python APIの完全な
リファレンスを含む、多くのページヘのリンクが掲載されています。

4.1 Pythonインタプリタの起動
Pythonインタプリタを起動するには、幾つかの方法があります。どの方法を使用

すべきかは、スクリプティングをどのように使用するかによります。Pythonインタ
プリタを使用するための、最も簡単で、かつこのチュートリアルで利用する方法は、
メニューからTools → Python Shellを選択することです。そうすると、ParaViewの
Pythonシェルのためのコントロールを有するダイアログが開きます。これがPython

インタプリタで、ここにコマンドを以下に述べるインタフェイスに従って入力する

http://catalyst.paraview.org/
http://www.paraview.org/documentation
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ことで、ParaViewを直接制御することが出来ます。

もし、とにかくスクリプトを書いてみたいのであれば、以下のスクリプティング
を起動するための他の方法を飛ばして、次節まで進んで頂いても構いません。
ParaViewには、Pythonスクリプトを実行するためのコマンドライン・プログラム
が、2種類付属しています。すなわち、pvpythonと pvbatchです。それらは、コマ
ンドラインまたはファイルからPythonスクリプトを読込んで、それをPythonイン
タプリタに渡す点で、Pythonの配布物に付属の python実行ファイルと似ています。
pvpythonと pvbatchの違いは、可視化を行う際の、微妙な手法の違いによるも
のです。pvpythonは、paraviewのクライアントGUIにおけるGUIを、Pythonイ
ンタプリタに置き換えたものと概ね同等と言えます。pvpythonはシリアル実行さ
れ、1つの ParaViewサーバ (ビルトイン、またはリモートのいずれも可) に接続さ
れるアプリケーションです。それに対して pvbatchは、ParaViewクライアントとの
ソケット通信の代わりにPythonスクリプトによって動作を指示される点を除いて、
pvserverと概ね同等です。pvbatchは (MPIサポート付きでコンパイルされていれ
ば) mpirunから起動することが可能な並列アプリケーションです。従って別のサー
バに接続することはできず、それ自身がサーバとなっています。一般的には、イン
タプリタを対話式に使うなら pvpythonを、並列に実行したい場合は pvbatchを使
用します。
ParaViewの Pythonモジュールを、ParaViewの外部のプログラムから使用する
ことも可能です。そのためには、PYTHONPATH環境変数に ParaViewのライブラリ
およびPythonモジュールへのパスを含め、LD LIBRARY PATH (Unix/Linux)、DYLD

LIBRARY PATH (Mac)、または PATH (Windows) 環境変数を、ParaViewのライブラ
リへのパスを含むように設定します。このようにして Pythonスクリプトを実行す
ることで、IDLEのようなサード・パーティのアプリケーションを使用することが可
能となります。環境設定に関するさらなる情報については、ParaView Wikiをご覧
下さい。

4.2 ParaViewの状態をトレースする
Pythonスクリプティングの機能について深く解説する前に、Pythonスクリプトを
作成するための自動化機能についてちょっと調べてみましょう。ParaViewのGUI上
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のPython Trace機能によって、多くの一般的な操作について、とても簡単にPython

スクリプトを作成することができます。Traceを使用するには、Toolsメニューにある
Start Traceからトレースの記録を開始し、同じくToolsメニューにある Stop Traceで
トレースの記録を停止します。これによって、GUIで行った操作を再現するPython

スクリプトが作成されます。このスクリプトには、今から述べるのと全く同じ記法に
よるプログラムが含まれています。したがって、Traceの記録はPythonインタフェ
イスによって同じ操作を行う方法を見出すための良い見本であり、逆に以下の解説
はあらゆる Traceスクリプトの中身を理解するのに役立ちます。

演習 4.1: Pythonスクリプトによるトレースを作成する
もし前節から演習を続けているのであれば、ParaViewをリセットする良い機会で
す。そのためには、メニューからEdit → Reset Sessionを選択するのが最も簡単です。

1. Toolsメニューの Start Traceをクリックします。

2. トレース用設定のダイアログボックスが表示されます。これらのトレース用設
定の意味については後ほど解説します。今はただ、OKをクリックします。

3. ParaViewのメイン GUIで、簡単なパイプラインを作成します。例えば、ス
フィア・ソースを作成した後、それをクリップして下さい。

4. Toolsの Stop Traceをクリックします。

5. 行った操作を再現するPythonスクリプトが記載された、編集ウィンドウが開
きます。

もしParaViewのPythonバインディングをまだ学んでいないとしても、トレース
されたスクリプトでどのようなコマンドが実行されるかは、自身で実行したので理
解しているでしょう。ひとたびハードディスクに保存されれば、お好みのエディタで
スクリプトを編集することももちろん可能です。最終的なスクリプトは、pvpython

またはpvbatchに読込ませ、完全に自動化された可視化を行うことができます。GUI

からこのスクリプトを実行することもできます。Python Shellダイアログには、保存
されたスクリプトを実行するための Run Scriptボタンがあります。 ♦

動作をトレースすることなく、現在の ParaViewの状態を Pythonスクリプトと
して保存する方法があることは、説明しておくべきでしょう。ParaViewの Fileメ
ニューから Save State...を選択し、(ParaView .pvsm state fileではなく) Python .py

state file を選んで下さい。状態を保存した Pythonスクリプトに関する演習はあり
ませんが、トレースによって作成した Pythonスクリプトと全く同じ様に使用でき
ると言えば十分でしょう。ぜひ自由にこの機能を使って、実験してみてください。
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先の演習の最初の方で説明したように、Pythonトレースには、トレース開始前に
表示されるダイアログボックスで表示される、いくつかの設定があります。1つ目の
設定は、トレースでどのプロパティが保存されるかの選択です。GUIウィジェット
での値の入力など、プロパティのいくつかはGUIを通して明示的に設定されます。
また、クリップ・フィルタが適用されるオブジェクトの形状に基づくクリップ平面の
初期位置など、いくつかは ParaViewアプリケーションによって内部的に設定され
ます。その他の多くのプロパティは、デフォルト値と同じままになっています。保
存するプロパティについて、以下の分類から 1つを選ぶことができます。

all properties(全てのプロパティ) たとえデフォルトのまま変更されていない場合で
も、全てのプロパティの値をトレースします。設定可能なプロパティの全てを
見直したり、他ユーザーの設定に関係なく間違いなく同じ状態になっているこ
とを保証する時には便利です。ただし、この設定にすると非常に冗長な出力が
生成され、解読が難しくなります。

any *modified* properties(*変更された*全てのプロパティ) デフォルトから変更
されていないプロパティを全て無視します。ほとんどのユーザーにはこの設定
が適しています。

only *user-modified* properties(*ユーザーによって変更された*プロパティのみ)

ユーザーによる明示的な設定がされていないプロパティを、全て無視します。
この設定によるトレースは、スクリプトが実行された時に再適用されている
内部設定プロパティに依存します。

その次の設定は、サーバの状態に依らず、ParaView GUI(またはクライアント)に
よって管理される補完的なオブジェクトに関係しています。カラーマップ、カラー
バー、その他の注釈といった、これらのオブジェクトに関連する全ての状態を保存
するには、このボックスにチェックして下さい。
最後に、ParaViewにはトレース・ファイルを生成中に、それを表示する設定があ
ります。ParaView GUIで行われた特定の操作を再現するためのPythonコマンドが
何かを学ぶためには、便利な設定です。
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4.3 マクロ
ParaViewの動作をカスタマイズするための簡単ながら強力な方法は、マクロとし

て自作の Pythonスクリプトを追加することです。マクロとは、メニュー・バーの
エントリやツール・バーのボタンによって起動することのできる、自動化されたス
クリプトです。あらゆる Pythonスクリプトを、マクロとして割当てることが可能
です。

演習 4.2: マクロの追加
この演習は、演習 4.1の続きです。この演習を始める前に、演習 4.1を完了させて
下さい。演習 4.1で作成されたPythonスクリプトが記載された編集ウィンドウを開
いておいて下さい。

1. (編集ウィンドウの)メニューバーで、File → Save As Macro... を選択します。

2. マクロにわかりやすい名前をつけて、ファイル・ブラウザによって示されたデ
フォルトのディレクトリに保存します。これでParaView GUIの上部にあるマ
クロ・ツールバーに自作のマクロが表示されているはずです。

この時点で、ツール・バーにマクロが追加されたことがお判りでしょう。デフォル
トでは、マクロのツールバー・ボタンは左端の中段に置かれます。GUI上のスペー
スが足りないようなら、このボタンを見るのにツールバーを適宜動かさなければな
らないかもしれません。また、Macrosメニューに追加されたことも、お判りいただ
けるでしょう。

3. Python編集ウィンドウを閉じます。

4. メニューから Edit → Delete Allを選ぶか、メニューから Edit → Reset Session

を選び、作成したパイプラインを削除します。

5. ツールバー・ボタンをクリックするか、Macrosメニューで選択すると、マク
ロが実行されます。

この例では、マクロにによってまっさらな状態から何かを作成しました。これは、
毎度同様にして何らかのデータを読込む場合には有用です。また、既に存在するデー
タに対して適用されるフィルタの作成をトレースすることもできます。このような
種類のトレースから作成されるマクロでは、異なるデータからの同じ可視化を自動
化することができます。 ♦
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4.4 パイプラインの作成
先の 2つの節で説明したように、ParaView GUIのPython Trace機能では、スク
リプトを作成するための簡単な仕組みを提供しています。この節では ParaViewス
クリプティングの基礎的な必要事項の説明を始めましょう。これは Pythonスクリ
プトの作成では重要な情報ですが、いつでもGUIを使ったトレース生成に戻ること
ができます。
ParaViewのためのあらゆるPythonスクリプトが行わなければならない最初のこ
とは、paraview.simpleモジュールの読込みです。これは、以下を実行することに
よって行われます。

from paraview.simple import *

一般に、このコマンドはあらゆるParaViewのPythonバッチ・スクリプトで行う必
要があります。このコマンドは ParaViewからスクリプティングのダイアログを起
動した時には自動的に実行されますが、(pvpythonと pvbatchを含む) その他のプ
ログラムでPythonインタプリタを使用する際には、明示的に行う必要があります。
paraview.simpleモジュールによって、ParaViewで定義されているあらゆるソー
ス、読込みオブジェクト、フィルタ、および書出しオブジェクトに対応するPython

の関数が定義されます。この関数名は、GUIのメニューで表示されるそれらの名前か
ら、空白と特殊文字を除いたものとなります。例えば、Sphere関数はGUIのSources

→ Sphereと対応し、PlotOverLine関数は Filters → Data Analysis → Plot Over Line

に対応します。それぞれの関数によってパイプライン・オブジェクトが作成され、(書
出しオブジェクトを除いて) それがパイプライン・ブラウザに表示され、さらにそ
のパイプライン・オブジェクトのプロパティを取得、または操作するためのプロキ
シ・オブジェクトを返します。
paraview.simpleモジュールには、その他の操作を行うための関数もあります。
例えば、Showと Hideの対になった関数は、パイプライン・オブジェクトのビュー
内での表示・非表示を切替えます。Render関数は、ビューの再描画を行います。
paraview.simple で 使 用 可 能 な 関 数 の 簡 潔 な リ ス ト を 得 る に は 、

dir(paraview.simple) を実行します。また、4.6 節で説明されている様に、
help(paraview.simple)で詳細リストを取得することができます。

演習 4.3: ソースの作成と表示
前節からの演習を行っていた場合は、ParaViewをリセットする良い機会です。その
ためには、メニューから Edit → Reset Sessionを選択するのが最も簡単です。
もし、まだ行っていなければ、メニューからTools → Python Shellを選択し、Para-

ViewのGUIからPythonシェルを開いて下さい。この操作によってPythonシェル
を起動した場合、

from paraview.simple import *
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は既に実行されています。
以下をPythonシェルに入力して、Sphereソースを作成および表示させて下さい。

sphere = Sphere()

Show()

Render()

Sphereコマンドによって、スフィア (球) のパイプライン・オブジェクトが作成
されます。Sphereコマンドを実行したら、パイプライン・ブラウザに項目が作成さ
れたのがお判り頂けると思います。このパイプライン・オブジェクトのプロキシは、
sphere変数に格納されています。この変数は (まだ) 使用されていませんが、この
ようにしてパイプライン・オブジェクトへの参照を保持しておくのは良い習慣と言
えます。
それに続く Showコマンドによって、ビュー内でのこのオブジェクトが表示状態と

なり、ついで Renderによって、その結果が見えるようになります。この時点で、再
びGUIを直接インタラクティブに操作できるようになります。ビューの視点の角度
を、マウスによって変更してみて下さい。 ♦

演習 4.4: フィルタの作成および表示
フィルタの作成は、ソースの作成とほとんど同様です。デフォルトでは、GUIでフィ
ルタを作成する時と同様に、最後に作成されたパイプライン・オブジェクトが、新
たに作成されたフィルタへの入力としてセットされます。
この演習は、 演習 4.3の続きです。この演習を始める前に、演習 4.3を完了させ

ておく必要があります。
Pythonシェルに、以下のスクリプトを入力して下さい。このスクリプトは、球を

非表示にしてシュリンク・フィルタを追加し、それを表示します。

Hide()

shrink = Shrink()

Show()

Render()

球は、Shrinkフィルタの出力によって置き換えられます。それによって球を構成
する全てのポリゴンが縮小され、爆発したような見掛けになります。 ♦

ここまで、パイプラインを構成する際には、デフォルトの設定を適用してきまし
た。しかしながら多くの場合、2章の演習で見られたように、プロパティ・パネルを
用いて設定を変更する必要があります。
Pythonによるスクリプティングでは、オブジェクトを作成する関数から返され

るプロキシを使用して、パイプライン・オブジェクトを操作します。これらのプロ
キシは実際のところ、プロパティ・パネルで設定するプロパティに対応するクラス属
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性 (プロパティ)を有する、Pythonのオブジェクトです。それらのプロパティは、プ
ロパティ・パネルの設定名から、スペースやPythonオブジェクト名に使用できない
文字を除いた名前を有します。アクセスする変数の全ての属性のリストを取得する
には、dir(variable)または help(variable)を使用します。ほとんどの場合、単
にオブジェクトの属性に値を代入することでそれらを変更することができます。

演習 4.5: パイプライン・オブジェクトのプロパティを変更する
この演習は、演習 4.3と 4.4の続きです。この演習を始める前に、演習 4.3と 4.4を
完了させて下さい。
ここまでに、sphereと shrinkの 2つの Python変数を作成しました。これらは
対応するパイプライン・オブジェクトのプロキシです。それではまず、以下のコマ
ンドを Pythonシェルに入力し、球の全ての属性の簡潔なリストを取得します。

dir(sphere)

次に、以下のコマンドを Pythonシェルに入力し、球の Theta Resolution プロパ
ティの値を取得します。

print sphere.ThetaResolution

Pythonインタプリタによって、8の値が返される筈です。(なお、Pythonシェル
は全てのコマンドの実行結果を出力するため、引数の Pythonオブジェクトを標準
出力に表示させる printキーワードは本来、不要です。)　このプロパティの値を
変えて、球の赤道方向のポリゴンの数を倍にしてみましょう。

sphere.ThetaResolution = 16

Render()

シュリンク・フィルタが持っているプロパティはただ一つ、Shrink Factorです。こ
の設定を調整すると、ポリゴンのサイズが大きく、または小さくなります。この値
を変更して、ポリゴンを小さくしてみましょう。

shrink.ShrinkFactor = 0.25

Render()

Pythonのコマンドを入力してパイプライン・オブジェクトのプロパティを変更す
るのに合わせて、GUIのプロパティ・パネルが更新されるのがお判り頂けると思い
ます。 ♦

ここまで、分岐の無いパイプラインだけを作成してきました。これは単純であり
ながら一般的なケースであり、paraview.simpleモジュールの他の多数の機能と同
様、このようなケースにおける作業量を最小限にとどめつつ、さらに複雑なケース
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にも対応できるような明確な道筋を提供できるよう設計されています。ここまで分
岐の無いパイプラインを構成してきたように、直前に作成されたオブジェクトは、
ParaViewによって自動的に次のフィルタの入力として接続されてきました。それに
よって、スクリプトはそれが行う操作の一連の流れとして読むことができるように
なっています。しかしながら、パイプラインに分岐が存在する場合には、フィルタ
の入力を明確に指定する必要があります。

演習 4.6: パイプラインを分岐する
この演習は、演習 4.3から 4.5までの続きです。この演習を始める前に、演習 4.3か
ら 4.4までを完了させて下さい (演習 4.5は任意です)。
今までのところ、sphereと shrinkという、2つの Python変数を作成しました。

これらは、対応するパイプライン・オブジェクトのプロキシとなっています。ここ
で、球のワイヤーフレームを抽出する 2つめのフィルタをスフィア・ソースに追加
しましょう。以下を Pythonシェルに入力してください。

wireframe = ExtractEdges(Input=sphere)

Show()

Render()

スフィア・ソースに、Extract Edgesフィルタが追加されました。元の球のワイヤー
フレームと、ポリゴンが縮小された球が同時に表示されている筈です。
ここで、ExtractEdges関数への引数として Input=sphereを与えることで、Ex-

tract Edgesフィルタへの入力を明示的に指定していることに注意してください。こ
こで実際に行われていることは、オブジェクトを作成する際に、Inputプロパティ
を与えることです。デフォルトの入力でオブジェクトを作成し、後で与えることも
可能ですが、推奨されません。それは、全てのフィルタが全ての種類の入力を受付
ける訳ではないためです 1。もし最初に誤った種類の入力によってフィルタを作成し
た場合、Inputプロパティを正しい種類の入力に変更する機会を得る前に、エラー
メッセージが表示されることとなる可能性があります。
出力に 2つのフィルタが接続されているスフィア・ソースは、扇型に広がるパイプ

ラインの例です。このように 1つの出力に複数のフィルタを接続することは、常に
可能です。一方で、全てではないものの、いくつかのフィルタは入力に複数のフィ
ルタを接続することが可能です。複数のフィルタを入力に接続することは、扇型に
束ねる接続と言えます。ParaViewのPythonスクリプティングでは、扇型に束ねる
ことは扇型に広げることと同様に、フィルタへの入力を明示的に指定することで行
います。(1つの入力ポートに 2) 複数の入力を接続するには、今まで 1つの入力を指

1訳注: たとえば、ParticleTracerフィルタへの入力は、Temporalタイプのデータセットである必
要があります。

2 原注: ResampleWithDatasetのような複数の入力ポートを持つフィルタでは、入力ポートを区
別するため、リストを使う代わりにポートごとに異なるプロパティ名を使用します。これらのポート
は基本的には “Input”および “Source”と呼ばれますが、Trace か helpを使って確認した方が良い
でしょう。
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定してきたところに、かわりにパイプライン・オブジェクトのリストを指定します。
例えば、シュリンク・フィルタとエッジの抽出フィルタの出力を、Group Datasets

フィルタを使って束ねてみましょう。以下の行をPythonシェルに入力して下さい。

group = GroupDatasets(Input=[shrink,wireframe])

Show()

シュリンク・フィルタとエッジの抽出フィルタの結果を表示させておく理由はも
はやありませんので、非表示にしましょう。デフォルトでは、Show関数と Hide関
数は、(フィルタを作成する際のデフォルトの入力と同様に) 最後に作成されたパイ
プライン・オブジェクトに対して作用しますが、引数に与えることで明示的にオブ
ジェクトを選択することができます。シュリンク・フィルタとエッジの抽出フィル
タの結果を非表示とするには、以下を Pythonシェルに入力してください 3。

Hide(shrink)

Hide(wireframe)

Render()

♦

前述の演習では、オブジェクトを作成する関数の引数を Input=⟨入力オブジェク
ト ⟩とすることで、Inputプロパティを指定できることを述べました。一般的にはど
のようなプロパティでも、⟨プロパティ名 ⟩=⟨プロパティの値 ⟩と指定することで、オ
ブジェクトの作成時に指定することができます。例えば、以下のような行によって、
球の作成時にTheta Resolutionと Phi Resolutionの双方を指定することができます。

sphere = Sphere(ThetaResolution=360, PhiResolution=180)

4.5 アクティブなオブジェクト
ParaViewのGUIを使った経験が少しでもあれば、アクティブなオブジェクトの
概念には既に慣れていることでしょう。GUIによって可視化パイプラインの作成や
操作を行うには、まずパイプライン・ブラウザでオブジェクトを選択する必要があ
ります。それ以外のプロパティ・パネルのようなGUIパネルは、アクティブなオブ
ジェクトが何であるかによって変わります。アクティブなオブジェクトは、フィル
タの追加のような操作でも、デフォルトのオブジェクトとして使用されます。
Pythonによるバッチ・スクリプティングにおいても、アクティブ・オブジェクト
の概念があります。実際、GUIとPythonインタプリタを同時に使用する場合には、
両者は同じアクティブなオブジェクトを共有しています。前節でフィルタを作成した

3訳注: Group Datasetsの実行によって二重に表示されていたオブジェクトが非表示となるだけな
ので、ビューの見掛けは変わりません。
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際、それらのフィルタに与えられるデフォルトの入力が、実はアクティブなオブジェ
クトです。新たなパイプライン・オブジェクトを作成したとき、(GUIでオブジェク
トを作成した時と同じように) その新たなオブジェクトがアクティブとなりました。
アクティブなオブジェクトは、GetActiveSourceおよび SetActiveSource関数に

よって、それぞれ取得および設定することができます。また、GetSources関数によっ
て、全てのパイプライン・オブジェクトのリストを取得することも可能です。GUIのパ
イプライン・ブラウザで新たなオブジェクトをクリックすると、Pythonでのアクティ
ブなオブジェクトもそのオブジェクトに変更されます。同様に、SetActiveSource

を Pythonから呼び出すと、パイプライン・ブラウザでは対応する項目がハイライ
トされます。

演習 4.7: アクティブなパイプライン・オブジェクトを試す
この演習は、前節の演習のつづきです。ただし、好みに応じて、いずれかのオブジェ
クトを適宜作成して、この続きを行うことも可能です。
以下によって、アクティブ・オブジェクトについて色々試してみて下さい。

• GetSources()を呼び出して、オブジェクトのリストを取得して下さい。その
リストの中から、作成したソースとフィルタを探して下さい。

• GetActiveSource()を呼び出して、アクティブなオブジェクトを取得して下
さい。それを、パイプライン・ブラウザで選択されているオブジェクトと比べ
て下さい。

• パイプライン・ブラウザでいずれかの新たなオブジェクトを選択し、GetAc-

tiveSource()を再び呼び出して下さい。

• SetActiveSource()関数によって、アクティブなオブジェクトを変更して下
さい。前に作成したプロキシ・オブジェクトのいずれかを、SetActiveSource

の引数として使用することができます。パイプライン・ブラウザで、その変更
を観察して下さい。

♦

アクティブなパイプライン・オブジェクトを保持するのに加えて、ParaViewの
Pythonスクリプティングでは、アクティブなビューも保持しています。ParaView

のユーザであるということで、既に複数ビューとアクティブ・ビューの概念にも慣れ
ていることでしょう。アクティブなビューは、GUIでは青いボーダーラインでマー
キングされています。Python関数の GetActiveViewと SetActiveViewによって、
アクティブなビューを問い合わせたり、変更することができます。パイプライン・オ
ブジェクトと同様に、アクティブなビューはGUIとPythonインタプリタの間で同
期しています。
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4.6 オンライン・ヘルプ
The ParaView Book や ParaView Wikiでの似たような使用説明と同様に、この
チュートリアルは、Pythonによるバッチ処理スクリプトを理解し、また作成するた
めに必要な重要な概念を提示することを目的に作成されています。利用可能な関数、
クラス、プロパティの一覧などを含む詳細なドキュメントは、ParaViewをビルドす
る過程において作成され、ParaViewアプリケーションのオンラインヘルプとして提
供されています。このようにして、ドキュメントがいかなるバージョンのParaView

であっても最新であり、容易にアクセス可能であることを確実としています。
ParaViewのPythonバインディングでは、help内蔵関数を利用しています。この
関数はあらゆる Pythonオブジェクトを引数に取り、そのオブジェクトに関する何
らかのドキュメントを返します。例えば、以下を入力すると、

help(paraview.simple)

paraview.simpleについての簡単な記述と、paraview.simpleモジュールに含まれ
る全ての関数のリストを、それぞれの概要とともに返します。さらに、たとえば、

help(Sphere)

sphere = Sphere()

help(sphere)

とすると、最初の行では Sphere関数に関するヘルプを表示し、つぎに Sphere関数
を使用してオブジェクトを作成し、さらに Sphere関数によって返されたオブジェク
トに関するヘルプを (そのプロキシの全てのプロパティのリストとともに) 表示し
ます。
プロパティ・パネルのPropertiesグループに表示されるウィジェットのほとんどは、

Pythonクラスを構築するのと同じ仕組みによって、自動的に生成されます (使いや
すさを向上させるため、少数ながら例外的に、カスタム・パネルを使用しているも
のもあります)。したがって、プロパティ・パネル上の名前が付けられたウイジェッ
トには多くの場合、Pythonオブジェクトにも同じ名前の対応するプロパティが存在
しています。
GUIにパイプライン・オブジェクトのカスタム・パネルが含まれるか否かにかかわ
らず、そのオブジェクトのプロパティに関する情報を、GUIのオンライン・ヘルプ
で得ることができます。いつものように、ツールバー・ボタンの によって、ヘル
プを表示させてください。ヘルプの Contentsの中の Sources、Filters、Readersおよ
びWriters項目の下には、全ての利用可能なオブジェクトに関するドキュメントがあ
ります。それぞれの項目には、そのタイプのオブジェクトのリストがあります。い
ずれのオブジェクトをクリックしても、Pythonから設定可能なプロパティのリスト
を得ることができます。
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4.7 ファイルからの読込み
ParaViewのGUIでファイルを開くことと同等の処理は、Pythonスクリプティン

グでは読込みオブジェクトを作成することです。読込みオブジェクトは、ソースや
フィルタとほぼ同様にして作成します。paraview.simpleには、それぞれの読込み
オブジェクトの種類について、パイプライン・オブジェクトを作成してプロキシ・
オブジェクトを返す関数が含まれています。あらゆる読込みオブジェクトは、以下
のようにして、あるいは、さらに簡単には reader = OpenDataFile(⟨filename⟩)を
呼び出すことによってインスタンス化することができます。
全ての読込みオブジェクトには少なくとも、ファイル名を指定するための (GUIか

らは見えない) プロパティがあります。このプロパティは慣習的に、FileNameまた
は FileNamesと呼ばれています。読込みオブジェクトを作成する際には、オブジェ
クトのコンストラクタへの引数で FileName=⟨ファイルへのフル・パス ⟩のように記
述することで、必ず有効なファイル名を与える必要があります。有効なファイル名
が与えられないと、読込みオブジェクトは多くの場合、正しく初期化されません。

演習 4.8: 読込みオブジェクトの作成
本演習ではまっさらな状態から可視化を行いますので、ここまでの演習を行ってこ
られた場合は、ParaViewを再起動するのにちょうど良いタイミングでしょう。そ
のためには、メニューから Edit → Reset Sessionを選択するのが最も簡単です。ま
た、Pythonシェルも必要です。もしまだ行っていなければ、メニューからTools →
Python Shellとして Pythonシェルを開いて下さい。
この演習では、Pythonシェルから disk out ref.ex2を読込みます。コンピュータ内

の disk out ref.ex2ファイルを探し、そのパスをPythonシェルに入力するかコピーで
きるようにして下さい。このファイルを以後、⟨path⟩/disk out ref.ex2とします。
以下を Pythonシェルに入力し、ファイル名を指定しつつ読込みオブジェクトを

作成します。

reader = OpenDataFile(’⟨path⟩/disk_out_ref.ex2’)
Show()
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Render()

ResetCamera()

一連のコマンドの末尾に、ResetCameraを追加していることに注意して下さい。
これは、disk out ref.ex2が標準設定のビューに収まらないためです。空のビューに
データが追加されると、GUIは自動的にカメラをリセットしますが、Pythonスクリ
プティングではそれが行われません。 ♦

4.8 フィールドの属性を問合せる
全てのパイプライン・オブジェクトのためのプロキシは、そのクラスに特定のプ
ロパティに加えて、共通のプロパティやメソッドを持っています。そのようなプロパ
ティの中でも特に重要な 2つのプロパティは、PointDataプロパティと CellDataプ
ロパティです。これらのプロパティは、Pythonにおける連想配列型である辞書のよ
うに振舞います。すなわち、(文字列で表された) 変数名を、フィールドの何らかの
特性を保持する ArrayInformationオブジェクトにマッピングします。ここで特記
しておくべきは、ArrayInformationのメソッドである GetNameで、これはフィー
ルドの名前を返します。GetNumberOfComponentsメソッドは、それぞれのフィール
ド値の成分の数 (スカラなら 1、ベクトルならそれ以上) を返します。GetRangeメ
ソッドは、ある特定の成分の最小値および最大値を返します。

演習 4.9: フィールド情報の取得
この演習は演習 4.8のつづきです。この演習を始める前に、演習 4.8を完了させて下
さい。
まず、節点型データへのハンドルを取得し、データが持つ全ての節点型フィール
ドを表示します。

pd = reader.PointData

print pd.keys()

“Pres”と “V”フィールドに関する情報を取得します。

print pd[’Pres’].GetNumberOfComponents()

print pd[’Pres’].GetRange()

print pd[’V’].GetNumberOfComponents()

それでは、もう少し凝ったことを試してみましょう。Pythonの for構文を使って、
全ての配列の全ての成分について、値の範囲を表示させます。

for ai in pd.values():

print ai.GetName(), ai.GetNumberOfComponents(),
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for i in xrange(ai.GetNumberOfComponents()):

print ai.GetRange(i),

print

♦

4.9 レプレゼンテーション
レプレゼンテーションは、パイプライン・オブジェクト内のデータとビューを結び

つける役割を果たします。レプレゼンテーションによって、どのようにデータセッ
トがビュー内で描画されるかが管理されます。レプレゼンテーョンによって、配色
やライティングのようなレンダリングにおけるプロパティに加え、データの描画に
用いられる内部的なレンダリング・オブジェクトが定義および管理されます。GUI

のDisplayグループにおいて設定可能なパラメータは、レプレゼンテーションによっ
て管理されます。全てのパイプライン・オブジェクトとビューのペアについて、個別
のレプレゼンテーション・オブジェクトのインスタンスが存在します。これは、そ
れぞれのビューがデータを異なったレプレゼンテーションで表示できるようにする
ためです。
レプレゼンテーションは、GUIによって自動的に作成されます。Pythonスクリプ

ティングでは、代わりに Show関数を使って作成します。つまり、Showがレプレゼ
ンテーションのプロキシを返します。したがって、これまでソース、フィルタ、読込
みオブジェクトで行ったのと同じ様に、Showの戻り値を変数に保存することができ
るのです。もし保存を怠っても、いつでも GetRepresentation関数で取得し直すこ
とができます。引数が何も無ければ、この関数はアクティブなパイプライン・オブ
ジェクトおよびアクティブなビューに関するレプレゼンテーションを返します。パ
イプライン・オブジェクトまたはビュー、あるいはそれら両方を指定することも可
能です。

演習 4.10: データの色づけ
この演習は、演習 4.8 (および、もし行っていた場合は、演習 4.9) のつづきです。ま
だ演習 4.8でのExodusファイルを開いていなければ、この演習の前に演習 4.8を完
了させて下さい。
形状の色を青色に変更し、鏡面反射によるハイライトをかなり強めに与えます (つ

まり、その形状に強い光沢を与えます)。Pythonシェルに以下を入力し、レプレゼ
ンテーションを取得して材質の特性を変更します。

readerRep = GetRepresentation()

readerRep.DiffuseColor = [0, 0, 1]

readerRep.SpecularColor = [1, 1, 1]
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readerRep.SpecularPower = 128

readerRep.Specular = 1

Render()

GUI上でマウスによってカメラを回転し、鏡面反射によるハイライトの効果を確
かめて下さい。
レプレゼンテーションは、フィールド変数によって色付けするためにも使うこと
ができます。以下を Pythonシェルに入力し、“Pres”フィールド変数によってメッ
シュを色付けして下さい。

readerRep.ColorArrayName = ’Pres’

readerRep.LookupTable = \

AssignLookupTable(reader.PointData[’Pres’], ’Cool to Warm’)

Render()

♦

4.10 ビュー
描画領域やウィンドウは、ParaViewではビューと呼ばれます。読込みオブジェク
ト、ソース、フィルタ、そしてレプレゼンテーションの様にビューはPythonオブジェ
クトでラップされていて、スクリプトから作成、取得、制御することができます。
通常、ビューはGUIによって作成されますが、Pythonの場合はもっと明示的に
ビューを作成しなければなりません。それを行うための最も手軽な方法は、Render

が必要に応じてまずビュー作成し、それを返すことを利用するというものです。ある
いは、CreateView(’⟨viewname⟩’)や CreateRenderView、CreateXYPlotViewなど
を使って特定のビュー型を作成することもできます。どのようにビューを作成したに
せよ、GetRenderViewを呼び出せば全てのビューのリストを取得し、GetActiveView
で現在アクティブなビューにアクセスすることができます。
いったんビューを取得すれば、GUIのViewグループに見えるプロパティの全てを
使用することができます。例えば、簡単に座標軸ウィジェットの表示、非表示を切
り替えたり、背景色を変更したり、光源を変更したりといったことができます。こ
れらの第 1階層のプロパティに加えて、ビューを使うことでカメラ、アニメーショ
ン時刻、またGUIを同時に実行していない場合でもビューの解像度といった、その
他のシーン全体に対するコントロールを使用できます。
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演習 4.11: ビューの制御
この演習は、演習 4.8 (および、もし行っていた場合は、演習 4.9と演習 4.10) のつ
づきです。まだ Exodusファイルを開いていなければ、この演習の前に所定の演習
を完了させて下さい。
それでは、シーンの背景色をParaViewのデフォルトの灰色から、見栄えのいいグ

ラデーションに変更してみましょう。ビューを取得し、変更するために以下をPython

シェルに打ち込んで下さい。

view = GetActiveView()

view.Background = [0, 0, 0]

view.Background2 = [0, 0, 0.6]

view.UseGradientBackground = True

Render()

次に、カメラがどの位置に設定されているかビューに問い合わせ、その後でそれ
を forループで動かして短いアニメーションを作ってみましょう。

x,y,z = view.CameraPosition

print x,y,z

for iter in xrange(0,10):

x = x + 1

y = y + 1

z = z + 1

view.CameraPosition = [x,y,z]

print x,y,z

Render()

♦

4.11 結果の保存処理
スクリプト内からの結果の保存は簡単です。データとスクリプトを保存すること

で、ParaViewを使って簡単に再現可能な可視化を作成することができるようになり
ます。
GUIでの作業と同様に、ParaViewでの作業中に保存しておきたい生成物がいく

つかあります。

• フィルタによって生成されたデータを保存するには、保存したいと思うソー
スを取得し、書き込みファイル名の作成、代入を行ってから書き込み用プロキ
シを更新します。これは、パイプライン・オブジェクトをクリックし、File →
Save Data を選択することに相当します。
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• 画像の保存はとても簡単で、SaveScreenshot(’⟨path⟩/filename.still ex-

tension’) と入力するだけです。

• ParaView が エ ン コ ー ダ や コ ー デック と リ ン ク さ れ て い る
場 合 、圧 縮 さ れ た ア ニ メ ー ション の 保 存 は と て も 簡 単 で 、
WriteAnimation(’⟨path⟩/filename.animation extension’) と入力す
るだけです。

どの場合でも、ParaViewはファイル名の拡張子から、作成するファイルの種類を決
定します。

演習 4.12: 結果の保存
この演習は、演習 4.8 (および、もし行っていた場合は、演習 4.9から演習 4.11まで)

のつづきです。まだ Exodusファイルを開いていなければ、この演習の前に所定の
演習を完了させて下さい。
まず始めに、何か小さな結果を得るために、データをサンプリングします。その
後で、テキスト・エディタで見たり、任意の他のツールにインポートできるように、
サンプリングしたものをカンマ区切り値形式で保存しましょう。

plot = PlotOverLine()

plot.Source.Point1 = [0,0,0]

plot.Source.Point2 = [0,0,10]

writer = CreateWriter(’⟨path⟩/plot.csv’)
writer.UpdatePipeline()

次に、プロットを表示するために LineChartViewを作成し、その結果のスクリーン
ショットを保存しましょう。

plotView = CreateView(’XYChartView’)

Show(plot)

Render()

SaveScreenshot(’⟨path⟩/plot.png’)

♦

ここまで見てきたように、ParaViewのスクリプティング・インタフェイスは実に
強力であり、いったんその基礎知識を取得し、Pythonの文法に慣れれば、作成、実
行は本当に簡単です。このチュートリアルでは、ParaViewの操作のスクリプト化に
おける高水準な側面に触れました。Pythonスクリプト化されたフィルタの実行方法
やNumPyといった他のツールとの連携方法、バッチ・スケジューラで実行するた
めにスクリプトをパッケージする方法など、より詳しい内容についてはオンライン
で見つけることができます。
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このチュートリアルに参加頂き、ありがとうございました。ParaViewを使って、
大規模データの可視化を始めるのに充分なだけ勉強されたことでしょう。以下には、
さらに情報を得るための情報源を挙げます。
ParaViewのウェブサイトのドキュメンテーション・ページにはさらなる学習と質

問のために利用できる資料のリストがあります。

http://www.paraview.org/documentation

The ParaView Guideは、ParaViewと一緒に持っておくのにとても良い情報源で
す。ここで学んだ以外の多くの使用法や、多くの機能に関するより詳細な説明が得
られます。The ParaView GuideはParaViewのドキュメンテーション・ページから
アクセス可能です。
ParaView Wikiは、ParaViewをセットアップして使用するのに役立つ情報が満載

です。

http://www.paraview.org/Wiki/ParaView

特に、並列 ParaViewサーバをインストールしたい方は、そのためのビルドおよび
インストールのページを必ずご参照ください。

http://www.paraview.org/Wiki/Setting up a ParaView Server

可視化や、ParaViewで利用可能なフィルタに関する詳細事項をさらに学ぶことに
興味がある場合は、以下の可視化に関するテキストを入手することをご一考下さい。

Will Schroeder, Ken Martin, and Bill Lorensen. The Visualization Toolkit. Kit-

ware, Inc., fourth edition, 2006. ISBN 1-930934-19-X.

ParaViewをカスタマイズしようとされているのであれば、上記の本およびウエブ・
ページに多くの情報があります。ParaViewが依存する可視化ライブラリの VTK、
GUIライブラリのQtの使用法に関する情報については、下記の本が参考となります。

Kitware Inc. The VTK User’s Guide. Kitware, Inc., 2006.

Jasmin Blanchette and Mark Summerfield. C++ GUI Programming with Qt 4.

Prentice Hall, 2006. ISBN 0-13-187249-4 (邦訳: 杵渕 聡、杉田 研治 訳「入門
Qt 4 プログラミング」オライリー・ジャパン、2007年、ISBN 978-4-87311-

344-9).

http://www.paraview.org/documentation
http://www.paraview.org/Wiki/ParaView
http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server


106 第 5 章 さらに情報を得るには

もし並列可視化の設計やVTKパイプラインの機能に興味があるのであれば、以
下の技術論文があります。

Kenneth Moreland. “A Survey of Visualization Pipelines.” IEEE Trans-

actions on Visualization and Computer Graphics, 19(3), March 2013.

DOI 10.1109/TVCG.2012.133.

James Ahrens, Charles Law, Will Schroeder, Ken Martin, and Michael Papka. “A

Parallel Approach for Efficiently Visualizing Extremely Large, Time-Varying

Datasets.” Technical Report #LAUR-00-1620, Los Alamos National Labora-

tory, 2000.

James Ahrens, Kristi Brislawn, Ken Martin, Berk Geveci, C. Charles Law, and

Michael Papka. “Large-Scale Data Visualization Using Parallel Data Stream-

ing.” IEEE Computer Graphics and Applications, 21(4): 34–41, July/August

2001.

Andy Cedilnik, Berk Geveci, Kenneth Moreland, James Ahrens, and Jean Farve.

“Remote Large Data Visualization in the ParaView Framework.” Eurographics

Parallel Graphics and Visualization 2006, pg. 163–170, May 2006.

James P. Ahrens, Nehal Desai, Patrick S. McCormic, Ken Martin, and Jonathan

Woodring. “A Modular, Extensible Visualization System Architecture for

Culled, Prioritized Data Streaming.” Visualization and Data Analysis 2007,

Proceedings of SPIE-IS&T Electronic Imaging, pg 64950I-1–12, January 2007.

John Biddiscombe, Berk Geveci, Ken Martin, Kenneth Moreland, and David

Thompson. “Time Dependent Processing in a Parallel Pipeline Architecture.”

IEEE Visualization 2007. October 2007.

もし ParaViewの並列レンダリングのアルゴリズムや構造に興味があるのであれ
ば、それらに関する技術論文もまた多数あります。

Kenneth Moreland, Brian Wylie, and Constantine Pavlakos. “Sort-Last Parallel

Rendering for Viewing Extremely Large Data Sets on Tile Displays.” Proceed-

ings of IEEE 2001 Symposium on Parallel and Large-Data Visualization and

Graphics, pg. 85–92, October 2001.

Kenneth Moreland and David Thompson. “From Cluster to Wall with VTK.” Pro-

ceddings of IEEE 2003 Symposium on Parallel and Large-Data Visualization

and Graphics, pg. 25–31, October 2003.

Kenneth Moreland, Lisa Avila, and Lee Ann Fisk. “Parallel Unstructured Volume

Rendering in ParaView.” Visualization and Data Analysis 2007, Proceedings

of SPIE-IS&T Electronic Imaging, pg. 64950F-1–12, January 2007.
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2分木法, 81

3D View, 8

3Dウィジェット, 29

3Dビュー, 8

AMR, 6, 17

animation save, 48–49

annotate time, 43, 44

apply button, 9

ArrayInformation, 100

AVI, 49

axes

center of rotation, 10

cube, see cube axes

orientation, see orientation axes

background color, 11

calculator, 16, 74

camera controls toolbar, see toolbar,

camera controls

can, 37

Catalyst, 87

CellData, 100

center of rotation

pick, 10

reset, 10

show, 10

center axes toolbar, see toolbar, center

axes

clip, 16, 21, 22, 29, 73, 76

color legend, 14

color palette, 47

color space, 36

colors

custom range, 39

edit, 14, 35

rescale, 39

common filters, 15–16

contour, 16, 18–19, 74–76

CreateRenderView, 102

CreateView(’hAviewnameB’), 102

CreateXYPlotView, 102

CTH, 17

cube axes, 12

custom data range, 39

cut, see slice

data analysis, 28

delete button, 12

depth peeling, 80

dir(variable), 94

disk out ref, 13

display lists, 80

display properties, 11

edit colors, 14, 35

encapsulated postscript, 48

EPS, 48

export scene, 31, 47–48

extract surface, 20

extract level, 16

extract subset, 16

extract group, 16, 75

extract selection, 28, 52, 56, 73

extract subset, 16, 73, 76

ExtractEdges, 95

filter

annotate time, 44
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calculator, 16, 74

clip, 16, 21, 22, 29, 73, 76

contour, 16, 18, 74–76

extract group, 16, 75

extract selection, 28, 52, 56, 73

extract subset, 16, 73, 76

glyph, 16, 27, 34, 75

group, 16, 75

histogram, 32, 75, 76

plot global variables over time, 28

plot over line, 28, 29, 75

plot selection over time, 28, 52, 55,

75

probe location, 28, 75

slice, 16, 74, 76

stream tracer, 16, 26, 34, 74

temporal interpolator, 42

threshold, 16, 73, 76

tube, 34

warp

vector, 16, 74

filters, 15–21

common, 15–16

data analysis, 28

filters menu, 16–17

find data, 50, 52–54

GetActiveSource, 97

GetActiveView, 97, 102

GetName, 100

GetNumberOfComponents, 100

GetRange, 100

GetRenderView, 102

GetRepresentation, 101

GetSources, 97

glyph, 16, 27, 34, 75

gradient, 11

group, 16, 75

group datasets, 16

GroupDatasets, 96

help, 95, 98

help(variable), 94

Hide, 92, 93, 96

histogram, 32, 75, 76

IceT, 81

immediate mode rendering, 80

Information, 8

interactive render

delay, 79

outline, 79

subsample, 84

joint photographic experts group, 46

JPEG, 46, 49

labels, 53–54

lighting, 12

LOD, 78

LOD Resolution, 79

LOD Threshold, 79

logarithmic scale, 36

macro, 91

memory inspector, 76–77

menu

filters, 16–17

sources, 8

movie, 48–49

mpirun, 88

NaN, 36

netCDF, 14

Ogg/Theora, 49

opacity, 12, 36

open, 13

ParaView, 1

paraview, 7, 64, 65, 88

ParaView Server, 64

paraview.simple, 98

ParaViewサーバ, 3
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PDF, 48

pipeline browser, 8

pipeline browser, 21

plot global variables over time, 28

plot over line, 28, 29, 75

plot selection over time, 28, 52, 55, 75

PlotOverLine, 92

PNG, 46, 49

PointData, 100

portable document format, 48

portable network graphics, 46, 49

postscript, 48

probe location, 28, 75

properties panel, 8

search, 11

proxy, see also Python, proxy

PS, 48

pvbatch, 88, 89, 92

pvpython, 3, 88, 89, 92

pvserver, 65, 88

Python, 87–104

ArrayInformation, 100

CellData, 100

CreateRenderView, 102

CreateView(’hAviewnameB’), 102

CreateXYPlotView, 102

dir(variable), 94

ExtractEdges, 95

GetActiveSource, 97

GetActiveView, 97, 102

GetName, 100

GetNumberOfComponents, 100

GetRange, 100

GetRenderView, 102

GetRepresentation, 101

GetSources, 97

GroupDatasets, 96

help, 95, 98

help(variable), 94

Hide, 92, 93, 96

macro, 91

paraview.simple, 98

PlotOverLine, 92

PointData, 100

proxy, 92, 93, 98, 99, 101

Render, 92, 93, 102

ResetCamera, 100

SetActiveSource, 97

SetActiveView, 97

Show, 92, 93, 96, 101

Shrink, 93

Sphere, 92, 93, 98

trace, 88–90

python, 88

quick launch, 17

real time (animation mode), 40

redo, 12

redo camera, 12

remote render threshold, 84

Render, 92, 93, 102

rendering, 77–86

interactive, see interactive render

parallel, 81–84

performance, 80

still, see still render

representation, 14–15

rescale colors, 39

reset session, 22

ResetCamera, 100

reset button, 10

save animation, 48–49

save screenshot, 31, 45–48

scalable vector graphics, 48

scalar range, 14

screenshot, 31, 45–48

select

block, 52

cells on surface, 51
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cells through, 51, 53, 56

cells with polygon, 52

frustum, 51, 53, 56

points on surface, 51

points through, 51

points with polygon, 52

polygon, 52

sequence (animation mode), 40

SetActiveSource, 97

SetActiveView, 97

shiny, 11

Show, 92, 93, 96, 101

Shrink, 93

slice, 16, 74, 76

Snap To TimeSteps (animation mode),

40

source

annotate time, 43

text, 42

sources, 8–12

sources menu, 8

specular highlight, 11, 101

Sphere, 92, 93, 98

Squirt, 83, 84

stream tracer, 16

stream tracer, 16, 26, 34, 74

subsample, 84

SVG, 48

temporal interpolator, 42

text, 42

threshold, 16, 73, 76

toolbar

camera controls, 9

center axes, 10

common filters, 15

data analysis, 28

trace, 89

transparency, 12

tube, 27, 34

undo, 12

undo camera, 12

view properties, 11

Visualization Toolkit, 3

VTK, 3

warp

vector, 16, 74

Zlib, 83, 84

しきい 値, 16

アクティブなビュー, 23

アニメーション・ビュー, 40

アニメーション・モード, 40

アノーテート・タイム, 43, 44

インタラクティブ・レンダー, 78

カット, see スライス
カメラのリセット, 9, 26

カメラのリンク, 24

キー・フレーム, 58

クイック起動, 18

クライアント, 64

クライアント－サーバ, 65

クライアント－レンダー・サーバ－デー
タ・サーバ, 65

クリップ, 16

グラデーション, 11

グラフ, 6

グリフ, 16

コンター, 16

ゴースト・セル, 69

サブセットの抽出, 16

シード点, 25

シーンのエクスポート, 47

スタンドアローン, 64

スティル・レンダー, 77

スライス, 16

ソース, 8

ソート・ラスト, 81
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ツール・バー, 8

テキスト・ソース, 42

テンポラル・インターポレータ, 41

データ・サーバ, 64

データにズーム, 9

データセットのグループ化, 16

データ型, 5

ディスプレイ・プロパティ, 11

ディテールのレベル, 78

トラック, 57

トレース, 89

ドッキング可能な, 8

ハロー領域, 69

バイナリ・スワップ法, 81

パイプライン・ブラウザ, 8

パラパラ漫画, 49

ヒストグラム, 32

ビュー, 102

ビルトイン, 64

フィルタ, 5, 15

プロキシ, 92, 93

プロパティ・パネル, 8

ベクター・グラフィックス, 47

ボリューム・レンダリング, 33

ポリゴン・データ (ポリ・データ), 6

マクロ, 91

マルチブロック, 6

メニュー・バー, 8

メモリ・インスペクタ, 77

ラスター・グラフィックス, 47

ラバー・バンド選択, 51

ラバーバンド・ズーム, 9

レプレゼンテーション, 101

レベルの抽出, 16

レンダー・サーバ, 64

ワープ
ベクトル, 16

一様直線格子 (画像データ), 5

可視化パイプライン, 15, 19

回転中心, 10

階層化一様AMR, 6

階層化適応メッシュ分割, 6

外部界面, 68

間引く, 82

基数 k法, 81

鏡面ハイライト, 11

曲線格子 (構造格子), 5

空間的にコヒーレントな, 69

結果の保存処理, 103

光沢, 11

高度なプロパティ, 11

座標軸, 10

辞書, 100

重畳, 81

小面, 10

制御点, 36

扇型に広がる, 95

扇型に束ねる, 95

浅いコピー, 72

伝達関数, 35

電卓, 16

等値面, 16

背景グラデーション, 11

背景色, 11

八分木, 6

非一様直線格子 (直線格子), 5

非構造格子, 6

表, 6

表示・非表示, 21

表面の抽出, 20
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流線, 25

流線追跡, 16

シード点, 25

連結状態, 21
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